
 

 

Autodesk Education Suite for Entertainment Creation
2012 Release Notes 

This document describes known limitations, issues and fixes in Autodesk Education Suite for 
Entertainment Creation 2012. It is strongly recommended that you read this document before you 
install this release. For reference, you should save this readme to your hard drive or print a copy. 
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Click the following links to view the Release Notes for this product: 

• Maya 2012 Release Notes 

• 3ds Max 2012 Release Notes 

• Softimage 2012 Release Notes 

• MotionBuilder 2012 Release Notes 

• Mudbox 2012 Release Notes 

• Sketchbook Designer Release Notes 

Additional Resources 

For complete instructions about uninstalling and installing Autodesk Education Suite for Entertainment 
Creation 2012, see:  

www.autodesk.com/me‐faq‐2012‐enu 

www.autodesk.com/me‐licensing‐2012‐enu 

For the Network Administrator’s guide see: www.autodesk.com/me‐nag‐2012‐enu 

For system requirements, see: www.autodesk.com/systemrequirements 

For more resources, see: http://www.autodesk.com/entertainmentcreationsuites‐documentation. 
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What’s New 

The following describes the new features and enhancements in the Autodesk® Education Suite for 
Entertainment Creation 2012. The Release Note information for each of the products in this Suite – 
Maya, 3ds Max, Softimage, MotionBuilder, Mudbox and Sketchbook Designer – is also included 
immediately after.  

Single‐Step Softimage Interoperability Workflows 

Iterative workflows between 3ds Max and Softimage can now be handled by clicking new items found in 
the application main menus.  In 3ds Max, you will find a Send to Softimage menu item that expands to 
allow you to Send as New [Softimage] Scene, Update Current [Softimage] Scene, and Add to Current 
[Softimage] Scene.  In Softimage, you will find the option Update Current 3ds Max Scene.  These 
workflows are facilitated by FBX 2012 technology, allowing for the exchange of 3D data (meshes, UVs, 
character rigs, particle simulation, etc.). 

Single‐Step MotionBuilder Interoperability Workflows 

Iterative workflows between Maya/3ds Max and MotionBuilder can now be handled by clicking new 
items found in the application main menus.  In Maya/3ds Max, you will find a Send to MotionBuilder 
menu item that expands to allow you to Send as New [MotionBuilder] Scene, Update Current 
[MotionBuilder] Scene, and Add to Current [MotionBuilder] Scene.  In MotionBuilder, you will find 
similar options to send to and update Maya/3ds Max.  These workflows are facilitated by FBX 2012 
technology, allowing for the exchange of 3D data (meshes, UVs, character rigs, etc.) and new features 
such as stereoscopic cameras, between Maya and MotionBuilder.  Existent merge‐back animation 
workflows involving Biped and CAT rigs (i.e. create in 3ds Max, animate in MotionBuilder and merge 
back into 3ds Max) and have been optimized as well. 

Single‐Step Mudbox Interoperability Workflows 

Iterative workflows between Maya/3ds Max/Softimage and Mudbox can now be handled by clicking 
new options found in the application main menus.  In Maya/3ds Max/Softimage, you will find a Send to 
Mudbox menu item that expands to allow you to Send as New [Mudbox] Scene, Update Current 
[Mudbox] Scene, and Add to Current [Mudbox] Scene.  In Mudbox, you will find similar options to send 
to and update Maya/3ds Max/Softimage.  These workflows are facilitated by FBX 2012 technology, 
allowing for the exchange of 3D data (meshes, UVs, character rigs, etc.) and new features such as Vector 
Displacement Maps, between Maya/3ds Max/Softimage and Mudbox.  Vector Displacement Maps are 
variations on regular displacement maps, allowing surfaces to be displaced in any direction, rather than 
solely along a surface’s normal.  It allows you to use displacement mapping to model far more 
sophisticated shapes with features like overhangs and undercuts; i.e. a human ear.  Mudbox can extract 
Vector Displacement Maps like standard displacement maps, and can use them as stamps and stencils 
for instant sculpting. 
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Consistent FCurve Editor 

Animation editors in Autodesk Digital Content Creation packages (Maya, 3ds Max, Softimage, etc.) are 
now more consistent with regards to the way in which function curves are manipulated by the user.  
Working between Autodesk Media & Entertainment packages is now a more consistent experience.  
Tangent types between applications have also been aligned, to allow for a higher fidelity in 
interoperability with FBX technology. 

Portable Characters 

HumanIK/Character rigs can be exchanged between Maya and MotionBuilder using single‐step 
interoperability workflows.  The Portable Character feature targets inter‐application animation 
workflows; i.e. a character is created in Maya, sent to MotionBuilder where motion capture or keyframe 
animation is applied and sent back to Maya. 

Supported Operating Systems 

The 32‐bit version of the Autodesk® Education Suite for Entertainment Creation 2012 software is 
supported by the following operating systems:  

• Microsoft® Windows® XP Professional Service Pack 3 

The 64‐bit version of the Autodesk® Education Suite for Entertainment Creation 2012 software is 
supported by the following operating systems:  

• Microsoft® Windows® 7 Professional 

• Microsoft Windows Vista Business Service Pack 1 

• Microsoft Windows XP x64 Edition Service Pack 2 

Hardware Minimum Requirements 

Note: The system requirements below are for users running several of the following products on the 
same system:  

• Autodesk® 3ds Max® 2012 software  

• Autodesk® Maya® 2012 software  

• Autodesk® MotionBuilder® 2012 software  

• Autodesk® Mudbox™ 2012 software  

• Autodesk® Softimage® 2012 software  

 

Note: The system requirements for individual products may differ from those in this document. 
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At a minimum, the Autodesk® Education Suite for Entertainment Creation 2012 software requires a 
system with the following hardware:  

• Minimum processor 
o Intel® Core™ two Quad 64‐bit processor  
o Dual‐Core Intel® Xeon® 64‐bit processor  
o Dual‐Core AMD Opteron™ 64‐bit processor  

• Recommended processor 

• Intel® Core™ i7 64‐bit processor  

• Dual Quad‐Core Intel® Xeon® 64‐bit processor  

• Quad‐Core AMD Opteron™ 64‐bit processor  
o 2 GB RAM minimum, 4 GB RAM recommended for the 32‐bit version 
o 4 GB RAM minimum, 8 GB RAM recommended for the 64‐bit version 
o 10 GB free hard drive space is required to install all commercial applications on the 

same system   

• 512 MB hardware‐accelerated OpenGL® 2.0 (and higher) professional graphics cards with 
recommended driver from Autodesk hardware certification pages. Three‐button mouse with 
mouse driver software. 

o DirectX 9.0c application programming interface or higher 

• Three‐button mouse with mouse driver software or certified Wacom® tablet 

• DVD‐ROM drive 

• Ethernet adapter or wireless internet card  

• 1280 x 1024 screen resolution 

Installing the Autodesk Education Suite for Entertainment Creation 

Load your USB key or navigate to the folder where you downloaded the Autodesk® Education Suite for 
Entertainment Creation 2012 executable file and double‐click on the file. 

Note: During the Suite 2012 installation process, you are requested to enter the software serial number 
and product key. Make sure you have the suite serial number and product key handy.  

Install and activate your products by following the on‐screen installation instructions. 

 

Microsoft .NET Framework 4.0 requires Windows Imaging Component 

If the Autodesk Installer prompts you to install the Microsoft .NET 4.0 Framework, the .NET 4.0 
Framework installer may prompt you to first install the Windows Imaging Component (WIC). This can 
occur if you do not have the latest Microsoft Windows updates or service packs. You are most likely to 
need WIC if you are running Windows XP SP2 without certain Windows Updates installed. If required, 
the Microsoft WIC installers are available at the following locations: 
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• 32‐bit installer 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=8e011506‐6307‐445b‐b950‐
215def45ddd8&displaylang=en 

• 64‐bit installer 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=f64654ac‐6e26‐41d9‐a90a‐
0e7783b864ee 

Uninstalling the Autodesk Education Suite for Entertainment Creation 

Windows XP 

1. Open the Add/Remove Programs dialog in Start > Settings > Control Panel.  
ve 
n.  

ll.  

s.  
e:  

all. 

2. Select the program to remo
3. Click on the Remove butto
4. Click Yes to confirm the Uninsta

Windows Vista and Windows 7 

1. Open Start > Control Panel > Programs > Programs and Feature
2. Select the program to remov
3. Click Uninst

Known issues and limitations 

Network licensing:  

• Suites licenses that are installed on the network can only be checked out by one system at a 
time (refer to the Network Licensing section in the Autodesk Suites Licensing Guide. You can 
view the PDF here.)   

For another user to be able to run any of the products on another machine using the same Suite 
license, all products must be closed on the first system. 

• Cascading issue with Softimage ECS, ESEC, 3ds Max ECSP and Maya ECSP suites. 
e. • The Turtle installer will NOT set up the Turtle shelf when the plug‐in is loaded the first tim

Users will have to run a command in the Maya Script Editor. 

The command is: loadNewShelf shelf_TURTLE.mel 
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Autodesk, Backburner, FBX, Maya, MotionBuilder, Mudbox, Sketchbook Designer, Softimage, and 3ds Max are registered 
trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other 
brand names, product names, or trademarks belong to their respective holders. Autodesk reserves the right to alter product 
and services offerings, and specifications and pricing at any time without notice, and is not responsible for typographical or 

graphical errors that may appear in this document. ©2011 Autodesk, Inc. All rights reserved. 



 

 
This document describes known limitations, issues and fixes in Autodesk Maya 2012. It is strongly 
recommended that you read this document before you install this release. For reference, you should 
save this readme to your hard drive or print a copy. 

Contents  

Additional Resources .................................................................................................................................... 1 

What’s New ................................................................................................................................................... 1 

What’s Fixed? ................................................................................................................................................ 1 
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Additional Resources  

For complete instructions about uninstalling and installing Maya 2012, see: www.autodesk.com/maya‐
faq‐2012‐enu. 

For complete documentation and learning resources, see: www.autodesk.com/maya‐docs. 

For hardware qualifications, see: www.autodesk.com/maya‐hardware. 

To report issues with this release, see: www.autodesk.com/maya‐support. 

For more resources, see: www.autodesk.com/maya‐learningpath. 

What’s New 

To learn about new features in Maya 2012, see: www.autodesk.com/maya‐whatsnewdocs. 

What’s Fixed?  

The following list contains bug numbers and corresponding descriptions for issues fixed in this release. 
For your convenience, the list is separated into distinct feature areas. 

API 

Bug Number  Description  

153122  MLibrary::initialize crashes on Windows if default project directory doesn't exist 

159047  MPxToolCommand::doFinalize()fails 

170988  MFnAttribute::setDisconnectBehaviour(MFnAttribute::kDelete) 

172891  MPlug numElements giving different results  

173501  Adding attribute to node then deleting node causes crash 

Autodesk Maya 2012 Release Notes
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Bug Number  Description  

175899  Crash when script re‐executes cmd from unloaded plug‐in or runTimeCommand 

176383  MFnNumericAttribute::create default values issues for double3/float3 

180033  getFlagArgument() doesn't work properly with multi‐use flags 

181665  Improvement of custom shader in devkit 

187354  Index parameter as a reference in some versions of MArgList::get 

201702  Input attributes on custom nodes problem 

205188  Cannot rewire connections to node to del in an addNodeAboutToDeleteCallback() 

213373  cvColorShader crashes Linux, Windows 

213497  Compound attribute array problem 

227153  MObject::apiType() fails for kData4Double type 

237690  loadPlugin command within userSetup.mel crashes Maya 

239509  Error when invoking model editor command 

244289  Plug‐in using MPxGlBuffer crashing 

245410  Cannot construct MRampAttribute when ramp attribute is empty 

251626  Crash in Interactive Prompt/Batch mode when calling MProgressWindow 

259795  Array version of MArgList::get() has different function params than others 

273987  Document MMessage callback function typedefs 

279601  Python: MItDependencyGraph::next() doesn't work because it refers NULL object 

298231  Declaration of 'className' method in API classes is inconsistent 

302127  There appears to be a memory leak in the MDGContext class 

309496  Calling MFnNurbsSurface::copy with parent dagPath argument causes crash 

314719  readAndWrite does not do what it advertises to do 

315016  MFnDependencyNode::hasAttribute() with non‐exist attribute name cause error 

316438  API enums passed as reference 

324634  loadPlugin behaves differently than documentation say 

327647  Crash with MPxSurfaceShape tweaks 

334176  MDGModifier doesn’t support setting plug value on single simple attribute 

336754  setCursor does not work in Python when using the default 

339833  Creating constraint using MDGModifier::createNode crashed Maya 

341199  MItDependencyGraph raises exception at end of iteration 

348996  MFnDependencyNode::hasAttribute() fails in python 

352107  MGlobal::getFunctionSetList() returns wrong types 

355451  Docs for MPxConstraint attributes missing/broken 

356921  objExporter crashed Maya 

361657  Viewing live device data during playback is broken 

364197  Import error with MotionBuilder 

366614  Transmit an MDoubleArray through attributes between nodes crashes Maya 

368071  Crash with PyQt GUI inside QmayaWindowEventFilterObject::eventFilter() 

369543  Maya module description file should support environment variables 
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Bug Number  Description  

369553  No documentation for custom hypergraph icons 

369970  No access to MDrawRequest's matrix 

370977  MLibrary::initialize has incorrect signature 

371413  Failure to read compound attributes 

212181 ‐ catchQuiet does not work properly 

catchQuiet now suppresses both MEL and Maya errors. Previously, catchQuiet would only suppress 
runtime errors and warnings issued by MEL. It has now been fixed to also suppress messages issued by 
Maya commands. 

Animation 

Bug Number  Description  

337159  3D motion blur causes crashes with muscles made with the muscle creator 

348994  blendShape does not work well with namespaces 

348998  skinCluster envelope attribute not working on Linux 

360016  Wrong description in helpfile 

362100  Hips translation does not work 

366567  PChar: Roll bone extraction behaves opposite to what is expected 

368147  HIK : ankle compensation AUTO does nothing 

368148  Auto mapping does not work with namespace 

369010  Painting skin weight for polygon without vertex or face causes crash 

371032  Toggle xray joints not syncing between paintWeights and panel 

374312  Exporting to HIK format visible in Maya GUI but does not work 

375220  Key modes not functioning 

375225  Autokey is not functioning on HIK 

377247  weightList ‐> weightList connection doesn't respond to changes as expected 

176266  Setting quaternion keyframes at 45 degrees in two axes issues 

208651  Synchronize quaternion behavior 

226110  Audio will not play or scrub backwards in Maya (Linux) 

285356  Graph Editor: Key Stats fields doesn't work when Normalize curves is on 

295536  Moving keys via MEL not work with normalized curve 

311108  Fcurve linear spline interpolation sometimes has round off errors 

317304  Set motion trail increment to zero crash 

321756  Maya freezes when scrubbing animation (driver issue) 

334472  Keys at high frame count may have round off error exporting to MotionBuilder 

354579  Linear tangents are not precise with big number 

354655  Newly created constraint nodes are incorrectly added to namespace 

355037  Expression collapses when dynamic attribute of expression node is used 

355905  Namespace added expression cannot open in external text editor (Windows) 
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Bug Number  Description  

355906  External Expression Editor corrupts expression 

356454  Playblast : improve error message when overwrite fails 

356501  Point on poly constraint with objects in namespaces 

357453  View Normalized crashes Maya when displaying angular animCurves 

316090  treeView callbacks not python compatible 

353238  Crash when creating animation layer 

369263  Crash on Animation Layer smart Bake with addAnimCurveEdited callback 

370275  Unable to use command to set keys in animation layers 

File I/O 

Bug Number  Description  

209041  Project problems when transferring  

224452  Import no longer use scene's current namespace 

232139  Documentation incorrect on workspace ‐dir and interaction with filebrowser 

238865  Cannot delete "lightLinker" nodes 

318517  Render ‐proj flag overwrites workspace.mel 

319964  Maya fails to launch if lastLocalWS is set to a read‐only directory 

348379  Namespace list is not cleared by "file ‐f ‐new" after "rename" of itemFilter 

352137  File command can't always find files in workspace "scene" location 

356148  File ‐edit ‐modified false doesn’t work correctly 

360138  Plug‐ins used in a scene are not saved correctly (if save panel layouts is off) 

361947  Double without decimal value saved as integer in Maya ASCII format and overflows 

363680  Problems with workspace.mel when rendering on a render farm 

365519  Crash on file save 

369753  File browser (windows style) defaults to saving files as maya ascii 

371560  Maya 2011 overwrites the workspace.mel file 

374798  Maya interfering with restart  

375943  Intelligent error handling when Deleting 'root' namespace 

380178  getAttr ‐expandEnvironmentVariables seems to permanently expand the value 

308583  exporting as OBJ causes Maya to crash  

370219  Export from Maya to Mudbox issues on Linux 64‐bit 
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File Referencing 

Bug Number  Description  

346698  Instances of grandchild reference lost when switched to proxy with shared edits 

355882  Shared edits aren't getting applied to a referenced Proxy 

356243  Nested proxy references : unloading/reloading in the Reference Ed. crashes Maya 

356371  Crash with ref joints and python commands 

360067  Namespace Editor does not refresh between scene loads 

360903  Editing on objects in referenced custom file is not saved 

361877  Import file problems with child reference edits 

363295  “lockNode ‐l 1 ;” causing mesh to lose shader assignment 

365154  ExportAsReference breaks render layers 

370178  Selective preload window is improperly formatted so you can't expand the list 

Fluids 

Bug Number  Description  

304303  Fluid illuminated by multiple lights gets extra intensity for each 

316282  Fluid should inherit velocity from collision object 

352379  Dispatched batch rendering fluid with retimed nCache produces incorrect result 

361705  Child ramp attribute of compound array attribute cannot be shown correctly 

Editors 

Bug Number  Description  

268706  Sluggish actions in Hypershade 

276226  Component Editor cannot edit namespace added meshes 

311068  Deleting color extra attribute causes crash 

340891  Camera Set Relationship Editor does not refresh 

359236  Writing the character number inside a string definition causes the rest of the line 
to appear as a comment 

364163  Maya hang on file save with isolated select and Outliner window 

365828  Issues with the new implementation  of File Browser 

365928  Cannot change multiple values at once in attribute spread sheet 

366783  plusMinusAverage can only set 1 decimal for 2D inputs 

366822  Dynamic Relationship Editor does not support full paths 

368729  Hypershade ‐ Toggle the create bar on / off 

369440  File browser only displays predictive folder names for C:/ 

371299  File Browser: typing in a folder name saves a file rather than navigating 

372738  Component Editor ‐ Smooth Skin Zero Weighting update issue 

375123  File Browser issues with new folders and date‐sorting 

376399  Component Editor: cannot paste value to multiple cells 
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Bug Number  Description  

378119  Changing enum attribute with multiple objects selected only changes one object 

Modeling 

Bug Number  Description  

339327  Working with construction history off causes history to stack up 

370294  Lattice crash (libPolyEngine) 

374003  Poly triangulation causes loss of UVs 

229834  Poly Combine/Separate don't respect multiple UV sets 

275392  Split Polygon Tool cannot split multiple faces from backface 

284563  MItMeshFaceVertex method normaId() causes crash in Maya 

296951  Split Polygon Tool cannot drag end point together with starting point 

299737  Crash in TpolyEditableGeom collapseEdge 

313140  Normals not correct with “Smooth Mesh” option 

318532  Combine breaks UV linking 

346216  Fill Hole crashes  

352585  "polyColorPerVertex ‐q" to object with no vertex color crashes Maya 

359356  Crash in conform/undo 

360931  polyBridge crashes Maya (empty Color Sets) 

361451  polyBridge crashes Maya 

361584  Repeatable crash during polyCleanup 

366936  Mesh Backface Culling crash 

371226  Scale manipulator disappears from UV texture editor when zooming out 

Nucleus 

Bug Number  Description  

278846  nCloth mesh slips down with non‐zero rigidity and high inputMeshAttract value 

348226  Painting cache weights from RMB menu does not create weight connections 

350296  outmesh precedes the inMesh with inputMeshAttract is set 

354931  getAttr on cache node connected outCacheData crashes 

369646  Instability triggered by self collision failure, e.g. at knees and elbows 

371073  Adding a Damp Texture to nCloth does nothing 

373920  Disable collision for nCloth problems  

355179  nParticles not simulating correctly, not getting license in batch 

369039  Per‐particle attributes not flushed after rewind 

372156  Select members on nParticles constraint gives incorrect results 

373036  Particle exclusion constraint applied to wrong object 

379348  Crashes when loading a scene with cached nParticles and multi object instance 
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Installation and Licensing 

Bug Number  Description  

348715  Uninstall issues 

358270  Maya does not start because d3dx9_42.dll was not found 

358922  Installer installs unnecessary files and folders 

360388  Log files for deployments should all go to a folder on the server 

362335  Error message appears on start 

364219  Uninstalling Maya 2011 Hotfix fails if it is installed by deployment 

369426  Environment setup issues 

372479  License Transfer Utility has incorrect shortcut target in Start Menu 

377945  Transfer license utility shortcut is broken 

Rendering 

Bug Number  Description  

296952  Opening UV Texture Editor crashes Maya if object doesn't have material 

321216  Multiple material overrides in referenced render layer breaks the render 

328935  Stereo horizontal interlace mode flips when resizing 

329153  stereoViewer refreshes more than it should 

329154  Stereo modelPanel and RenderView give different anaglyph images/results 

338715  Playblasting images performance issues 

356800  Backburner Web Monitor is unable to quit server tasks in process 

356688  Color management conversions between color spaces issues 

363303  Maya main GUI does not appear 

364497  Hypershade Bookmark crash 

369851  "spotLight ‐name lightName" does not return light's name  

360939  16‐bit half float EXR output of color managed renderings result in unusable file 

372487  Batch bake creates clamped color set 

378585  Textures with transparency draw incorrectly  

267280  Previous hardware displays cannot display correctly multiple UV and textures 

352089  Hardware render doesn't recognize extension padding 

355177  MGeometryManager gives wrong element count 

361362  Crashes during Hardware Render Buffer render 

239367  multi texture with different UV sets and alpha are not displayed in viewport 

268575  Viewport rendering does not support multiple UV sets 

369361  Different CPU counts combined with Tessellation Error has different results 

375649  Using the ‐amt flag is not exiting renders 

302958  mental ray crash with a CAD file 

331212  BSP2 and Instances not rendering 

333388  Particular framebuffer names for OpenEXR multipass are not exported correctly 
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Bug Number  Description  

333626  Nested references problem 

358514  misss_physical creating artifacts and no material 

361720  Light's Photon Intensity attribute broken 

362476  mib_texture_lookup returns wrong color when filter is on with rasterizer 

365451  overall_bump input from empty file texture used as normal map crashes Maya 

371499  Color management issues 

359270  Background gradient edits ignored by Viewport 2.0 

360447  Directional light shadows not working with Viewport 2.0 

369255  OGS: Viewport 2.0 will not run on Radeon 5870 unless maya.exe is renamed 

377014  Performance problems with custom renderer 

380529  Performance problem with render target parameter on MShaderInstance 

Color management improvements  

Maya 2012 includes improvements made to color management accuracy and image format support. See 
bugs 356688 and 360939 in the What's Fixed list above for more information. 

Scripting 

Bug Number  Description  

212181  catchQuiet does not work properly 

219424  Print 1e256 causes a crash 

266995  Python commands attached to menuItems produce error after restarting  

267915  maya.cmds.shadingNode returns None in batch mode 

269148  mayapy.exe: first object creation command doesn't echo the value. 

295972  Python created scriptJobs are not listed on "listJobs" 

309041  maya.cmds.menu( postMenuCommand=somethingCallable ) leaks memory 

310567  Python shelfButton command cannot create MEL sourceType 

317083  Memory Leaks in maya.cmds 

318920  Python: scriptJob fails to handle "quitApplication" event 

319438  Maya Python memory leak with strings 

323126  gradientControlNoAttr doesn't list all the flags 

329204  substituteAllString can cause infinite loop 

331947  MFnUInt64ArrayData.create returns kIntArrayData obj, not kUInt64Array 

334611  catchQuiet doesn't work on referenceQuery errors 

348048  Keyframe ‐q incorrect if attribute is locked 

349500  textField* commands ‐editable false and ‐enable false inconsistent behavior 

357506  editAttrLimits.mel with wrong code 

363254  Prompt mode fails to connect to sockets 

366922  objectTypeUI "viewPanes"; failure 
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Plug‐ins 

Bug Number  Description  

369536  Cannot load 'Substance.so' plug‐in  

371530  Substance plug‐in fails to load  

General UI 

Bug Number  Description  

177417  shelfButton ‐dragCallback and ‐dropCallback do not work 

192779  setFocus not working properly from command line with quad‐split model view 

199419  Closing a torn off menu crashes 

214835  Hotbox grabs Xserver 

269968  Create a locator, keep selected and open the Channel Control crash (Mac) 

278144  Wacom pen interferes with Hotbox 

297039  Display iconTextButton on FormLayout (Mac) 

315338  Hangs while switching panel views and clicking during redraw 

316336  Limiting the redraw to single pass for each refresh 

321157  Maximize window not working properly 

322990  Maya child windows are not 'raised' when told to 

323966  frameLayout's size does not follow its parent's size 

327349  optionMenu doesn't appear when initial window size is small on 64‐bit Windows 

356048  Tablet pressure breaks undo 

356303  Add the abolition of labelAlign option of frameLayout in the online document 

356641  Unresponsive marking menu's when right clicking using Wacom pen 

357484  Tweak Mode only modifies in a certain axis 

361689  Font installing problems  

363797  objectTypeUI does not work anymore with menuItem instances 

364226  Crash: iconTextButton/iconTextCheckBox/iconTextRadioButton delete from 
callback 

366337  Using dual screen Hotbox works on primary but not secondary monitor 

368109  Hotkeys are not assigning correctly or saving 

369075  Hotbox can't move torn off menus 

369758  Hotbox display issues (Linux) 

370084  Drag and drop to previous version problem 

370342  libQtCore crash when navigating through static to dynamic attribute connection 

371803  Minimizing Render View Window does not hide contents 

374318  Pressing space bar in viewport shifts entire session 

374399  Sticky mouse focus (Mac) 

377428  Hotbox appears under active window when set to always on top 

228719  Cut faces icon dithered 
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Bug Number  Description  

243470  User Color changes not persisting 

271454  The editable flag of the checkBox command does not work 

286095  Display Layer's "Make New Layer's Current' and templating error 

337641  Double‐click to select edge loop inconsistencies 

342512  Random crashing whilst clicking 

349279  Trial version label error 

352293  Shelf icons not loading on startup 

352756  Closing Render View doesn't restore focus to model view 

353503  Shelf Icon format preference does not save 

353746  Image command no longer reads IFF 

354067  Hypershade won't display materials 

356147  Refresh error 

356239  Render layer override orange text going grey when not in the Attribute Editor 

356902  Help > Direct Connect Help fails 

359057  getModifiers command returns incorrect values (Mac) 

359266  Maya does not save preferences for View Cube Compass 

360622  Change Maya foreground color (Linux) 

360911  Empty tab with tabLayout 

361915  Shelf icons resize to full size upon exiting and re‐opening Maya 

361956  Custom shelf buttons disappear upon start 

362290  Preferences corrupted when ViewAxis HUD (HUDViewAxis) is removed 

362566  Default Hotkeys reset themselves upon re‐opening Maya 

363499  Display layer move selection up and down does not work 

363909  My custom shelf contains no buttons, new buttons cannot be made 

364036  formLayout ‐attachForm doesn't work with iconTextButton and iconTextCheckBox 

364377  Shortcut key defaults keep over riding user changes 

364524  Renaming an item in the Shelf Editor selects the item at the top of the list 

367064  UV Texture Editor snap and grid display incorrect while using "Use Image Ratio" 

369415  Deferred dialog problem 

370285  File dialog renames incorrect file/folder 

371129  Shaders with connected transparency don't display 

371964  Mouse input freezes after Hotbox or menu interaction 

373806  Row not found error 

374513  Extension no longer determines file type 

375741  Creating lights doesn't return the name of the new light node 

377467  Cannot rename button pop‐up menu 

222149  Maya launches a file called "C:/Program" if it exists (Windows) 
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358426 ‐ Some controls named with "#" retain it in their object names 

In previous versions of Maya, controls named using the "#" sign would retain the sign in their default 
labels/titles. For example, creating a button called "myButton#" with no label would create a button 
with an object name like myButton1 but the default label on the physical button was "myButton#". 
Likewise, creating a window called "myWindow#" with no title would create a window with an object 
name like myWindow1, but the default title in the window's title bar was "myWindow#".  

With this fix, this no longer occurs. myButton1 will have a default label of "myButton1" and myWindow1 
will have a default title of "myWindow1". 

369974 ‐ Namespace UI modifications: "Create Reference" window 

Previously, the “Name clash” settings in the File > Create Reference and File > Import options were 
slightly different. These are now consistent. 

Miscellaneous 

Bug Number  Description  

362548  Organize files in Bonus tools 

324638  Cloth scripts missing and/or location changed ‐ cleanup classic cloth references 

231287  Large number of connections between two nodes slows down Maya 

347811  Document DIRTY PROP, CLEAN PROP & DIRTY BLOCK  

349382  Slow node selection with animation layers 

366589  Standard particle caching and opacity problems 

372735  BMP image causes crash if it is used for iconTextButton 

353517  Segmentation fault on startup 

339703  HUD frame rate displays partially off screen 

360131  Edit and Delete buttons in Hotkey Editor show inactive states (Mac) 

276518  Symbolic linked directory path is converted to real path unexpectedly 

342917  Active Directory Accounts do not work (Mac) 

357550  Script Editor window is rendered unreadable on gesturing right 

362006  Tool tips not working in Hypergraph heat map display 

371656  Windows don't minimize, they disappear 

353624  atan2 documentation incorrect 

354604  splash.dll file missing 

354734  splash.dll problem 

355142  Unused script nodes and performance 

355972  Opening Visor crash 

356304  Application file has stopped working 

356993  menuItems created in Python do not respect arguments passed to them 

357382  AutoSave with prompts 

357546  More than one voice (language) talking at same time in learning movies 
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Bug Number  Description  

358004  Load the Maya Muscle plug‐in first 

361646  Wacom support problems 

361777  shelfLayout does not resize vertically when used in a formLayout 

362024  The script editor does not open 

368804  TGA support with the image() command 

370122  Eyedropper color sampling freezes application 

352811  Playblast does not record certain frames 

Feature Limitations and Notes 

The following section describes limitations and other notes about this release. For your convenience, the 
list is separated into distinct feature areas. 

API and Scripting 

Bug Number  Description  

279601  Python: MItDependencyGraph::next() doesn't work because it refers NULL object 

315016  MFnDependencyNode::hasAttribute() with non‐existent attribute name causes 
error 

348996  MFnDependencyNode::hasAttribute() fails in Python 

349036  Infinite recursion if maya.utils not found 

368766  MFnLightDataAttribute::setObject() does not work 

Animation 

Bug Number  Description  

366275  HIK: Channel Box or Attribute Editor values ignored by effectors (sync issue) 

357076  Sequencer: File path still points to old location when relocating media files 

359322  Get rid of Sequencer node ‐ merge with SequenceManager 

379846  Reading a 2011 file adds an additional bone between legs 

381291  HIK : Pull doesn't work in context of retargetting 

381927  Can't edit motion trail tangents with Soft Selection 

381954  Selecting tool clears selection in the Graph Editor 

382154  HIK: Shift+LMB does not allow for selection of keys on timeline if HIK in scene 
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Dynamics 

Bug Number  Description  

361522  Problem with too many wrinkles  

361361  Bend restitution has no effect when using simple bend solver 

365231  Fluid and nCache both delete when deleting fluid cache 

358255  Nucleus lockup during interaction (Mac) 

327800  vertexColor texture fails when no color set on first frame 

356574  Ramp widget handles 50 entries, but ramp attribute can have more 

372111  Editing nucleus transform at start frame requires rewind 

372115  Problem with solving nParticles in a moving local frame 

374787  Assign solver fails when all nucleus Attribute Editor display transforms are on 

375400  Particle Instancer rotation not caching with Aim direction set to force 

376912  Use Polygon Shells ‐ On/Off at start frame requires another rewind 

376927  nParticles project file crashes Maya 

377823  getCacheable channels still cache grids that were turned off 

380245  Trying to shatter a firework hangs Maya (NURBs shatter can be VERY slow) 

380797  Cache resolution mismatch 

380888  Cache confusion with two or more fluid shape nodes with the same name 

381961  Duplicating PhysX geometry causes Maya to freeze 

Modeling 

Bug Number  Description  

333874  Selection Constraint Angle does not work 

Interoperability 

Bug Number  Description  

382399  Default displacement scale one‐click needs adjustment 

380838  ICEFlow ‐ Static deformations don't update in Maya 

381203  MotionBuilder to Maya (when closed) doesn’t load the file until the File menu is 
clicked 

Rendering and Render targets 

Bug Number  Description  

360939  16‐bit half float EXR output of color managed renderings result in unusable file 

355710  Remove time contrast settings from mental ray globals 

378635  Inconsistent color output when rendering EXR and TIFF with mental ray Depth Pass 

380204  Cancel Batch Render does not (Linux) 
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Bug Number  Description  

380322  Scenes with dense final gather settings may have longer render times 

382158  Warnings occuring in mental ray standalone 

372275  Hide mental ray attributes in the Attribute Editor when plug‐in isn't loaded 

368762  Separate mental ray plug‐in from Maya 

380236 
The SatinedMetal preset for the mia_material may have a slightly different 
rendered result 

380520  Batch render target rendering not supported for more than one renderable 
camera 

380993  Batch render unable to render rendertargets in SGI, PSD and ALS 

380537  Aborting a render target render incorrectly displays render target name in Render 
View 

379526  Render target recursively filter renders 

382287  layeredTexture node clamping float values 

381206  Render Target  Aspect ratio issue  

380660  RenderTarget : Aspect Ratio incorrect with orthographic cameras 

379010  Incidence render pass fails to be read from EXR render to Render Target 

379007  Material Incidence pass fails to read in Render Target at 16‐bit integer (defaults) 

381082  RenderTarget : horizontal shift when used with Stereo Camera 

General UI 

Bug Number  Description  

357561  Minimized windows don't appear in dock and don't stay minimized (Mac) 

376551  Render View appears blank with error message 

377392  Hypershade loses visual connection with projected textures 

381128  Attribute Editor slow to update when selecting camera in scene with CgFX 

323322  Color scheme makes UV Texture Editor resizing option obscured (Mac) 

350866  Hypershade is slow to open (Mac) 

353866  Files greyed out in File browser (Mac) 

356339  File browser doesn't update if the window is open 

359228  Opening windows (like Attribute Editor) does not bring them to the top if already 
open 

369409  connectControl performance issue 

380317  Tear off the Recent Commands menu from the Hotbox will not update 

356182  Dockable Attribute Editor not refreshing after resourcing AEnodeTemplate 

358130  Unattached picture object in formLayout doesn't show up 

376333  Scene with multi‐byte name can't be transferred to Mudbox in JP version 
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Bug Number  Description  

376955  Impossible to pick Color with pen tablet (Mac) 

377236  Outliner auto‐scroll bug 

378069  Errors showing Attribute Editor with some custom attributes 

379019  Render View sometimes empty during render (Mac) 

356688  Color management conversions between color spaces are inaccurate and unable 
to round trip 

355340  Hotbox shifted by height/width of border panels when using overlays (Linux) 

Miscellaneous 

Bug Number  Description  

355821  artUserPaintCtx : if Undo is off, Maya crashes after Flood is used 

371917  Must use “.” for numbers with LANG environment variable set 

378047  Close batch render option box before changing renderers  

380473  No manipulator handles in perspective view, but available in all other views 

382222  Fur Paint Export Map fails 

382310  Remove the ‐exportAsSegment flag of file command and associated methods 

370985  Difficulties publishing blend shape sliders due to default published name 

356665  No preferences to set Attribute Editor opening behavior 

362615  Must set International > Formats > Region to see installer in Japanese (Mac) 

381032  CIP: Maya sometimes won't start in  Japanese mode (Mac) 

API/Scripting Notes 

214262 ‐ MRampAttribute::Interpolation should match internal representation 

Previously, the values of the MRampAttribute::MInterpolation enumeration did not match the 
corresponding values placed into the the ramp's interpolation attribute. While the MRampAttribute 
class itself took care to perform the correct translation whenever setting or retrieving interpolation 
values, problems could arise if users tried to set or or retrieve interpolation values directly, using plugs, 
data handles or MEL commands. To resolve this inconsistency the MRampAttribute::MInterpolation 
enumeration has been adjusted to match the actual values set in the attribute. 

For the most part existing code should continue to work without any changes, particularly if it only 
accessed interpolation values through the MRampAttribute class. However, if you have code which was 
explicitly working around the old problem by translating MInterpolation values to/from the raw 
attribute values, then you may need to remove or modify that translation code. 

362497 ‐ MFnMesh::setFaceVertexColors doesn't work with locked dcol attribute 

Previously the MFnMesh functions which set colors (e.g. setVertexColor) would automatically turn on 
color display on the mesh node. This has been changed so that the methods leave the node's color 
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display option unchanged. If you want to turn it on then you must do so explicitly either by calling the 
new setDisplayColors method or by setting the mesh node's 'displayColors' attribute to true. 

366299 ‐ Remove overlay drawing methods from M3DView 

The overlay drawing methods in M3dView (beginOverlayDrawing, endOverlayDrawing and 
clearOverlayPlane) haven't worked properly since hardware overly support was removed in Maya 2011. 
Those methods have now been removed from API and the sample plug‐ins which used them have been 
updated to use the XOR drawing methods instead (beginXorDrawing, endXorDrawing). 

368813 ‐ MFnAttribute::setParent() doesn't add attribute to new parent 

The MFnAttribute::setParent() method has been removed. It was exposing an internal Maya function 
which, on its own, was not useful and could corrupt a node's attribute hierarchy. To properly set an 
attribute's parent, use MFnCompoundAttribute::addChild() to add it to its parent. 

368766 ‐ MFnLightDataAttribute::setObject() does not work 

Light data attributes, such as those created by MFnLightDataAttribute, were incorrectly reporting their 
type as MFn::kCompoundAttribute rather than kLightDataAttribute. This has been fixed. In most cases 
the change will be transparent to API users but it is possible that you may have code which is explicitly 
checking light data attributes for kCompoundAttribute, in which case you will have to update your code 
accordingly. 

377401 ‐ namespaceInfo ‐listOnlyDependencyNodes includes internal nodes 

namespaceInfo ‐listOnlyDependencyNodes is listing all nodes, including internal nodes and world. This 
behavior is not consistent with how we generally return lists like this to the user by default.  Instead, by 
default, it should work in a similar manner to the default behavior of ls ‐dependNode where internal 
nodes are skipped. To support compatibility with the previous behavior, we added a new flag 'internal' 
which will cause the command to include all the nodes that it previously did. 

Animation 

367419 ‐ Preserve compatibility with Maya2011 MayaHIK setups 

We made some changes that will change the compatibility with the previous files. These should be 
addressed at load time  

• hikFKJoint and hikIKEffector are now used in place of joints and hikEffectors. While the old 
setups would evaluate properly, some new code may fail. 

• Inputs PinT and PinR were replaced with output pinT and pinR.  

• Percentages values on property2State node are now ranging from 0 to 1 instead of 0 to 100. 
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378677 ‐ Animation curve different between Maya 2011 and Maya 2012 

Animation curves with tangents set to quaternion cubic and quaternion tangent‐dependent have been 
improved to provide smoother interpolation. This means that files from previous versions with these 
tangent types will produce different results. 

381276 ‐ Setting jointOrient attributes individually badly recomputes vector 

Problem: Setting joint orient values individually on x, y or z in the attribute editor or via a command may 
result in a new joint orient triple. This is because the value is stored internally as a quaternion.  

Workaround: Set all three joint orient values at once. For example: 

setAttr "joint1.jo" ‐type "double3" 90 0 0; 

HIK 

367419 ‐ Preserve compatibility with Maya 2011 MayaHIK setups 

HIK  retargeting rigs from Maya 2011 will play back, but do not work with the new HIK UI in Maya 2012.  

Licensing 

Sentinel 1.2 breaks a Sentinel 1.1 install on Macintosh 

This will affect any product that has integrated Sentinel 1.1 for the Mac that is installed on a machine 
where Sentinel 1.2 has already been installed.  So far Maya 2011 is the only product we have identified 
as having integrated Sentinel 1.1 for the Mac.  Basically what is happening is that LMU.app and LTU.app 
are not installed on the machine for Sentinel 1.1.  This will affect both network and standalone license 
types. 

Workaround:  The supported fix would be for users to copy the LMU.app and LTU.app packages 
manually onto the machine.   

380146 ‐ DMM cinematic plug‐in fails to load on Linux 

Maya is not compatible with selinux enforcing settings. 

378003 ‐ Core dump by running setup on Fedora 14 

Fedora 14 requires one to use a fully root account to run GUI programs. Do the following:  

su –  

Then run the installer.  

This is a "new" security feature of Fedora 14.  
http://fedoraforum.org/forum/showthread.php?p=1423295 
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Rendering/mental ray 

375080 ‐ Render passes may exhibit poor shading quality with Adaptive Sampling 

Workaround: Select Fixed Sampling instead of Adaptive Sampling in the Render Settings: Quality tab. 

380813 ‐ mental ray shadow map overrides does not disable 'Use Ray traced Shadows' in Light 
Attribute Editor 

Previously, enabling 'Use mental ray shadow map overrides' in a Light Attribute Editor disabled 'Use Ray 
Trace Shadows'. This is not the case in Maya 2012, and 'Use Ray Trace Shadows' must be disabled 
manually. 

380847 ‐ Maya may stop unexpectedly if mental ray is used to render scenes with extra shape nodes 

If your scene contains extra shape nodes, for example, objects that are not meshes, and render with 
mental ray for Maya, this may cause Maya to stop unexpectedly.  

Maya File I/O 

380799 ‐ Saving files to paths that include '.' causes files to be saved without an extension 

When saving a file, if your path includes a '.', your file may be saved without an extension. To 
workaround this problem, enter .ma or .mb after your file name before saving. 

352137 ‐ File command can't always find files in workspace "scene" location 

Previously, using the workspace command to set your "scene" file rule only worked for your mayaAscii 
and mayaBinary files in the current session of Maya. If you re‐open Maya, you must have your 
"mayaAscii" and "mayaBinary" workspace file rules set to this directory also; otherwise, an error 
appears. 

In Maya 2012, your "scene", mayaAscii and mayaBinary file rules are all considered when a scene file is 
located. Maya first looks in the location defined by the "scene" file rule, then mayaAscii, then 
mayaBinary. Therefore, the default location for all scene files (.ma, .mb) is the location defined by the 
"scene" file rule, regardless of file type.  

If you have defined different locations for your mayaAscii and mayaBinary files, you must explicitly set 
the file location to use these, as they do not appear at the default location. 
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mental ray Satellite and Standalone 

382129 ‐ xinetd needs to be installed on the Linux platform to allow for network rendering with 
mental ray Standalone and mental ray Satellite 

To install, as a super user, execute the following command: 

yum install xinetd 

Then reboot before installing mental ray Standalone or mental ray Satellite. 

Nucleus 

361522 ‐ problem with too many wrinkles with previous versions 

If you load an nCloth scene file from a pre‐2011 version of Maya, set bendAngleDropoff to zero to 
preserve the existing behavior of the cloth.  

BendAngleDropoff previously had little effect on simulations; however it now has a strong effect on 
bend resistance. Higher values now result in less bend resistance where the cloth is flatter. 

Miscellaneous 

Link to video in Maya Help What's New page does not accept UNC‐style paths 

The Camtasia video link on the 'What's New in Autodesk Maya' page of the Maya help does not show 
the 'What’s New movies' if you access the help from a UNC‐style path (for example, \\remote‐drive\). In 
order to play the movies from this link, you must either install the Maya 2012 Help to a local hard drive 
(for example, C:\) or map a drive to the network location where the help is installed.  These movies play 
properly if you access the help from the Autodesk web site. 

311729 ‐ Comments link generates corrupted page in Japanese Safari (Mac OS X) 

If you click the “Please send us your comments about this page” link at the bottom of a topic in the 
Maya Help in Japanese Safari, the help system returns a corrupt page.  

Workaround: Use another browser (such as Mozilla Firefox) to send comments. 

369409 ‐ Possible connectControl slowdown 

When using a large number of controls, and issuing commands that take control names (for example, 
connectControl), you should follow these guidelines to increase efficiency: 

1) Set the parent to the relevant layout or window using setParent before using a large number of 
commands for the same layout/windows. 

2) Use the short name for each control. 
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379816 ‐ OGS: dynamics scenes must play back forwards first when using Vertex Animation Cache 

When using the Vertex Animation Cache attribute with a simulation, you must first play the simulation 
forward once in order for the Vertex Animation Cache to build its cache correctly. After doing this, you 
can scrub the timeline as you like. Note that rewinding the simulation to Frame 1 does not reset the 
cache. 
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Installation Issues  

Prerequisites 

Before an end‐user with restricted Windows® operating system privileges can use Autodesk 3ds Max 
2012 / Autodesk 3ds Max Design 2012, an administrator, with full privileges, must install and start the 
software one time in order to generate the Windows operating system registry information needed to 
complete the installation. 

Before an end‐user with restricted privileges can use third‐party plug‐ins for Autodesk 3ds Max 2012 / 
Autodesk 3ds Max Design 2012, an administrator, with full privileges, must install and start 3ds Max 
2012 / 3ds Max Design 2012 one time in order to generate the necessary folders for these third‐party 
plug‐ins. 

Microsoft .NET Framework 4.0 requires Windows Imaging Component 

If the Autodesk Installer prompts you to install the Microsoft® .NET 4.0 Framework, the .NET 4.0 
Framework installer might prompt you to first install the Windows Imaging Component (WIC). This can 
occur if you do not have the latest Microsoft Windows updates or service packs. You are most likely to 
need WIC if you are running Windows XP SP2 without certain Windows Updates installed. If required, 
the Microsoft WIC installers are available at the following locations: 

• 32‐bit installer 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=8e011506‐6307‐445b‐b950‐
215def45ddd8&displaylang=en 

• 64‐bit installer 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=f64654ac‐6e26‐41d9‐a90a‐
0e7783b864ee 

Release Version with Beta 

If there are previously installed versions of any beta software (including Release Candidate (RC) 
versions) of Autodesk 3ds Max 2012 / Autodesk 3ds Max Design 2012, uninstall and delete all system 
folders pertaining to these beta versions before installing the commercial version. Instructions on how 
to uninstall the beta versions are posted on the beta portal in the Beta and RC Readme files. 

Leaving Ports Open 

Autodesk 3ds Max or Autodesk 3ds Max Design, Autodesk® Vault, Autodesk® Backburner™, and various 
other components of the install, require that certain ports be open in third‐party firewalls. If you are 
having problems with your firewall, read the documentation included with your firewall. 
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Port Conflict with mental ray (When Installing Autodesk 3ds Max 2012) 

During the Autodesk 3ds Max installation process (from the install wizard) the mental ray® port is 
assigned automatically and cannot be changed from the install wizard.   In most cases this is fine.  In a 
rare case a conflict arises if the port is already occupied.  In such a case you will receive this error 
message: 

 

To fix this issue, perform the following steps: 

1. Using a text editor, open the setup.ini file (located at the root of your install media). 
2. Search for the [MAX] section. 
3. You need to reassign mental ray to a different port number by adding this line under 

EXE_PATH=  
EXE_PARAM= MR_TCP_PORT=[YOUR PORT NUMBER] 

Where [YOUR PORT NUMBER] is replaced by the port number you want to assign to mental 
ray. 

4. Save the setup.ini file and run the installer again. 

Installing the IPv4 or IPv6 Versions of Network License Manager 

You can install the IPv4 version of the Network License Manager from the Tools and Utilities tab in the 
3ds Max 2012 / 3ds Max Design 2012 installer.  If you need to install the IPv6 version of the Network 
License Manager, you can do so from Autodesk.com at the following location: 

www.autodesk.com/nlm‐ipv6‐windows 
 

The IPv4 version that is on the Tools and Utilities tab is also available on Autodesk.com at: 

www.autodesk.com/nlm‐ipv4‐windows  

Installing Local Help 

Starting this release, the 3ds Max Help is being published in HTML format to the Autodesk.com website. 
By default, 3ds Max calls the help from a Web location to provide you with the latest documentation 
available. This shift to publishing directly to the Web means we can provide regular updates and 
additions to content in an ongoing manner. This change also significantly reduces the footprint of locally 
installed data to your machine and makes the install and uninstall of 3ds Max quicker.  
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To download a local version of the Help: 

1. In 3ds Max, go to Customize menu > Preferences > Help panel. 
2. Click Download and download the Help installer from Autodesk.com.  (The URL for the page is 

http://www.autodesk.com/3dsmax‐helpdownload‐enu.) 
3. Once installed, enable Local Computer / Network. 

Note: If you changed the install location from the default you will need to specify your path.  

Now when you go to Help > Autodesk 3ds Max Help you will view the local version.   

Customer Involvement Program (CIP)  

The first time 3ds Max / 3ds Max Design is started, the Customer Involvement Program dialog opens. If 
you choose to participate in the Customer Involvement Program, 3ds Max or 3ds Max Design will 
automatically send Autodesk information about system configuration, which features are used most 
frequently, problems encountered, and other information helpful to the future direction of the product. 
For further information, see www.autodesk.com/cip. 

To enable CIP: 

1. Install and start 3ds Max / 3ds Max Design. 
2. If the Customer Involvement Program dialog box is not displayed automatically, then in the Help 

menu, click Customer Involvement Program.  
3. In the Customer Involvement Program dialog box, select "Participate ‐ with contact 

information."  
4. Enter a valid email address and company name, if any. Click OK.  

Customer Error Reports (CERs) 
We can improve the stability of Autodesk 3ds Max / Autodesk 3ds Max Design largely because of the 
Customer Error Reports (CERs) that end‐users submit. We thank you for taking the time to fill out these 
reports and ask you to include as much information as possible about what actions you were performing 
at the time the error occurred. These details raise the value of the report immensely and are very much 
appreciated by the Autodesk 3ds Max Quality Engineering team.  

For further information about CERs refer to www.autodesk.com/cer.  
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Feature Limitations and Notes 

The following are the major known feature limitations and notes for Autodesk 3ds Max 2012 / Autodesk 
3ds Max Design 2012:  

Feature  Limitations and Notes

Autodesk® Alias® Products 
Interoperability  

 

• When adding modifiers to some production models, a memory 
error can occur and cause a program error. 

• Off‐Set Pivot points are not supported from .WIRE files. 
• Planer surfaces created from text do not fully import in .WIRE 

files 
• Textures Maps assigned to Alias shaders do not import from 

.WIRE files. 
• Stitched surfaces import from .WIRE with the original surface. 
• Not all Alias material/shader parameters persist in .WIRE files 

and might require some adjustment once imported. 
• Only surfaces are supported, not curves and meshes. 
• Scene hierarchy: When surfaces are stitched together, naming 

might not persist. 

Autodesk® Civil View  • Autodesk Civil View trees display and render entirely white. 
Workaround: Turn off the material settings for Self‐Illumination. 

• The Civil View exporter in AutoCAD® Civil 3D® cannot locate the 
VSPCFG file which contains the material settings, so the 
exported files import into 3ds Max without the corresponding 
materials assigned.  
Workaround: Navigate to the Civil 3D Data folder 
(C:\ProgramData\Autodesk\C3D 2012\enu\Data) and manually 
select the VSPCFG file found there. 

Autodesk Consistent 
Materials 

• Converting Metal: Copper can cause incorrect values in the 
diffuse channel. 

Autodesk® FBX®  • There might be more recent versions of the FBX plug‐ins than 
the ones included with both 3ds Max and 3ds Max Design.  Click 
Web updates in the Information rollout of the FBX Exporter and 
Importer windows regularly so you can be sure that you are 
running the latest FBX plug‐in version. 

 
You can find the latest FBX plug‐ins here: 
www.autodesk.com/fbx‐downloads 

Freeform Brushes  • Using the Constrain to Spline brush can cause performance 
issues when used with Edit Poly modifier. 
Workaround: Converting the base object to an Editable Poly 
avoids these performance issues.  

MassFX  • Composite Physical Meshes on very small objects sometimes 
cause a program error when you click the Generate button. 

• Having the Dynamics Explorer or Scene Explorer open while 
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Feature  Limitations and Notes

running a simulation or while baking can cause the simulation 
performance to degrade. 

Nitrous 

 

• Applying Unwrap UVW after painting in 2D with Viewport 
Canvas and painting on top of the Unwrap UVW can sometimes 
cause 2D paint to fail.   
Workaround: If this occurs, apply an Edit Poly modifier on top 
of the Unwrap UVW modifier. 

• Civil View parameters can cause a program error when 
modifying surface parameters. 

• Object Color display will show the object’s material color when 
set to object color.   
Workaround: Enable Use Environment Background and Display 
Background in the Viewport Background settings (Alt+B). 

• Locking the computer can cause the viewports to stop 
responding in some cases.   
Workaround: If this occurs, restart the program. 

• Mirrored or negatively scaled objects might display face edges 
incorrectly. 

• The Soft selection Shade Face Toggle does not always properly 
display the shaded faces. 

• MassFX constraints can cause Dummy objects not to display in 
Realistic mode. 

• Body Objects display tessellated/triangulated edges instead of 
the proper Body curves. 

• Back faces display as transparent. 
• Hidden Line style does not display texture maps in the viewport. 
• Tone Mapper used with a Skylight set to use the mr Physical Sky 

environment will display a black background when enabled.   
• Enable Gamma/LUT Correction does not work on stylized 

viewports. 
• Very large textures (10K x 10K) can cause a program error.  

Workaround:  You can control texture sizes with MAXScript:  
NitrousGraphicsManager.SetTextureSizeLimit 512 true 
NitrousGraphicsManager.SetBackgroundTextureSizeLimit 1024 
true  
Or by modifying the following keys in 3dsmax.ini:  
[Nitrous]  
ViewportTextureSizeLimitEnabled=1 
ViewportTextureSizeLimit=512 
ViewportBackgroundTextureSizeLimitEnabled=1  
Note:  You need to restart 3ds Max after making these changes. 

Skin  • Opening the Weight Tool dialog causes features in the Weight 
Properties rollout to fail. In addition vertex weight assignment 
might not work. 

Substance  • If you double‐click the output pane of the Substance browser, it 
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Feature  Limitations and Notes

fails with a MAXScript error. 

Unwrap UVW  • Peel mode does not update in the UVW editor when new seams 
are created with the Point‐to‐Point tool.  
Workaround: To update the cluster, after creating the seam, 
click anywhere in the Edit UVWs dialog window with Peel Mode 
active. 

• Peel Mode does not update in the UVs Editor using seams with 
Convert Edge Selection to Seams tool.   
Workaround: To update the cluster in the UVW Editor, toggle 
Peel Mode twice. 

• Using the Reset Peel function outputs all positions of the 
clusters in the MAXScript listener window. 

• Scale options do not work as intended when choosing the three 
different options.   
Workaround: Pressing Ctrl+Alt when using uniform scale will 
give more predictable results. 

• After applying Reset UVWs and functions that use GroupIDs, a 
program error might result.  These functions include Peel, Pack, 
Rescale Elements, and Group Tools. 

• (Nitrous only) Applying Unwrap UVW to the object corrupts 2D 
View in Viewport Canvas. 
Workaround: Apply the Edit Poly modifier on top of the Unwrap 
UVW or convert the object to Editable Poly format. 

• Sub‐Object cannot be deselected in Command panel or UVs 
Editor.  
Workaround: Click an empty viewport. This will deselect Sub‐
Object from geometry and texture. 

• Peel Mode causes faces to become unhidden when using 
Display Only Selected Faces. All hidden faces/clusters will be 
unhidden. 

XBR Diet  • Callbacks might not be registered with 3ds Max if a plug‐in is 
defer loaded.   
Besides action tables and core interfaces, a plug‐in might need 
to register with 3ds Max other callbacks and objects that affect 
the user interface such as, but not limited to:  

o Action item override names: See 
IActionItemOverrideManager::ActivateActionItemOverri
de()  

o Geometry Checkers: See 
IGeometryCheckerManager::RegisterGeometryChecker(
)  

o Drag and drop handlers: See class 
DragAndDropHandler.  

o Menus other than those based on action items: See 
IMenuManager::RegisterMenu() 
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Feature  Limitations and Notes

o Viewport buttons: See 
IViewportButtonManager::RegisterButton().  

o Trackbar filters: See ITrackBarFilterManager:: 
RegisterFilter() 

o Object converters and Collapse types: See 
RegisterObjectConverter(), RegisterStaticEditTri() , 
RegisterEditTriObjDesc() and RegisterEditPolyObjDesc() 

At this time the plug‐in loading mechanism in 3ds Max does not 
detect these cases and as a result, it will defer load such a plug‐
in DLL unless it explicitly disallows deferring. 

• Deferred plug‐ins might miss pre‐notifications such as 
NOTIFY_FILE_PRE_OPEN since they may only get loaded as a 
result of a scene, material library, or other file being loaded. If 
the plug‐in relies on a pre‐notification to initialize some of its 
data structures, or it registers for both pre‐ and post‐
notifications (ex: NOTIFY_FILE_POST_OPEN) and expects them 
to always occur as an ordered pair (NOTIFY_FILE_PRE_OPEN 
first, NOTIFY_FILE_POST_OPEN second), the plug‐in might not 
work correctly if defer loaded. 
 
Workaround: Force the plug‐in to opt out from the defer 
loading mechanism in 3ds Max by implementing CanAutoDefer() 
as follows: 
__declspec( dllexport ) ULONG CanAutoDefer()  
{  
   return FALSE;  
} 

 

Autodesk, Alias and 3ds Max are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries 
and/or affiliates in the USA and/or other countries. mental ray,  mental mill and iray are registered trademarks 

of mental images GmbH licensed for use by Autodesk, Inc. All other brand names, product names, or 
trademarks belong to their respective holders. Autodesk reserves the right to alter product and services 

offerings, and specifications and pricing at any time without notice, and is not responsible for typographical or 
graphical errors that may appear in this document. 

© 2011 Autodesk, Inc. All rights reserved. 



 

 

Autodesk Softimage 2012 Release Notes 

This document describes known limitations, issues and fixes in Autodesk Softimage 2012. It is strongly 
recommended that you read this document before you install this release. For reference, you should 
save this readme to your hard drive or print a copy. 

Contents 
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What’s Fixed ................................................................................................................................................ 14 

Additional Resources 

For complete instructions about uninstalling and installing Softimage 2012, see: 
http://www.autodesk.com/softimage‐faq‐2012‐enu 

For hardware qualifications, see: www.autodesk.com/softimage‐hardware  

To report issues with this release, see: www.autodesk.com/softimage‐support  

For more resources, see: www.autodesk.com/softimage‐learningpath  

For the most up‐to‐date release notes for Softimage 2012: www.autodesk.com/softimage‐readme‐
2012‐enu  

What’s New 

UI & General  

 New Web-based Help and user preference for setting online or offline Help locations.  

 Added a STOP button to the playback control panel.  

 The Schematic View now shows links for custom and scripted operators and more hotkey options. 

See also the Schematic View API changes in the SDK.  

 Syflex and Polygonizer plug-ins are now fully translated into Japanese.  

 Added Primitive > Polygon Mesh > Empty for ICE Trees.  

 You can now use 32-bit Quicktime on 64-bit Windows.  

 Added Preferences > Display > Image Clip Thumbnail Size.  

 You can now load progressive JPEG in Windows XP with a limited account or on Windows with UAC 

enabled.  
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ICE  

 New Simulation Settings property added to ICE simulated scene elements for controlling sub-frame 

calculations.  

 Lagoa scenes and compounds updated to comply with sub-frame interpolation.  

 Blast compound v.2.1 changed to properly respect end duration.  

 New ICE Nodes:  

 Get Orthogonal Basis  

 Build Array from Set  

 Reference To String  

 New FrameStep  

 New GetSetMedian  

 Create Strand From Curves  

 Modified ICE Nodes:  

 Cache On File  

 New input port that can use a string node to define the path  

 New input port to control the caching mode  

 New Subframe Mode to cache all simulation samples  

 New PPG logic to keep the path visible in all modes  

 Modifier Deformation > Modulate by Null  

 Modifier Deformation > Turbulize Around Value  

 Modifier Deformation > Turbulize Value by Range  

 New ICE Attributes:  

 Intrinsic Attributes  

EdgeID, EdgeToCCWPolygon, EdgeToCWPolygon, EdgeToNextEdgeCCW, 
EdgeToNodes, EdgeToVertices,  
MaterialID, Materials, NodeID, NodeToEdges, NodeToPolygon, NodeToVertex, 
NodeUserNormal,  
PointUserMotions, PolygonalDescription, PolygonID, PolygonToEdges, 
PolygonToNodes, PolygonToVertices,  
Topology, VertexID, VertexIsBorder, VertexIsCorner, VertexToEdges, 
VertexToNodes, VertexToPolygons 
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 Custom Attributes Exposed by Compounds  

Display_StrandToMesh_PackedPolygons, 
Display_StrandToMesh_PositionsPerObject 
IsOnSlicePlane, SlicePolyMesh_PlaneNormal, SlicePolyMesh_PlaneOrigin 
StrandToMesh_ExtrusionID, StrandToMesh_IsCapEnd 
StrandToMesh_IsCapStart, StrandToMesh_LastIDFirstExtrusion 
StrandToMesh_NbExtrudedSide, StrandToMesh_NbSections 
StrandToMesh_NbSides, StrandToMesh_PackedPolygons 
StrandToMesh_Polygon_U, StrandToMesh_Polygon_V 
StrandToMesh_SpacingRatio_U, StrandToMesh_SpacingRatio_V 
StrandToMesh_Texture_Projection 

 Topology Task tab in the Preset Manager now has a set of high-level compounds to help 

you quickly get to work with ICE Modeling:  

 Topology/Conditionals/Test Edge Index 
 Topology/Conditionals/Test Index Is Valid 
 Topology/Conditionals/Test Polygon Index 
 Topology/Conditionals/Test PolyNode Index 
 Topology/Conditionals/Test Polygon Inside Null 
 Topology/Conditionals/Test Vertex Index 
 Topology/Copy and Merge/Build Topology Array 
 Topology/Copy and Merge/Copy Default Rendering Attributes 
 Topology/Copy and Merge/Copy Edge Data from Source 
 Topology/Copy and Merge/Copy Material Attributes 
 Topology/Copy and Merge/Copy Polygon Data from Source 
 Topology/Copy and Merge/Copy PolyNode Data from Source 
 Topology/Copy and Merge/Copy Texture Projection from Source 
 Topology/Copy and Merge/Copy Vertex Data from Source 
 Topology/Copy and Merge/Merge Data Sets to Array 
 Topology/Copy and Merge/Merge Edge Data 
 Topology/Copy and Merge/Merge Material ID 
 Topology/Copy and Merge/Merge Polygon Data 
 Topology/Copy and Merge/Merge PolyNode Data 
 Topology/Copy and Merge/Merge Texture Projections 
 Topology/Copy and Merge/Merge Vertex Data 
 Topology/Copy and Merge/Random Material ID per Copy 
 Topology/Copy and Merge/Transform per Copy 
 Topology/Generators/Clone Polygon Mesh 
 Topology/Generators/Create Copies from Polygon Mesh 
 Topology/Generators/Create Extrusion Along Strands 
 Topology/Generators/Merge Polygon Meshes 
 Topology/Getters/Get Closest Edge Index from Null 
 Topology/Getters/Get Copy Index 
 Topology/Getters/Get Edge Index from Test 
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 Topology/Getters/Get Edge Index 
 Topology/Getters/Get Edge is on Edge Loop 
 Topology/Getters/Get Edge Loop 
 Topology/Getters/Get Invalid Index 
 Topology/Getters/Get Material ID 
 Topology/Getters/Get Materials 
 Topology/Getters/Get Polygon Index from Test 
 Topology/Getters/Get Polygon Index 
 Topology/Getters/Get Polygon is on Edge Loop 
 Topology/Getters/Get Polygons Inside Null 
 Topology/Getters/Get PolyNode Index from Test 
 Topology/Getters/Get PolyNode Index 
 Topology/Getters/Get Topology 
 Topology/Getters/Get Vertex Index from Test 
 Topology/Getters/Get Vertex Index 
 Topology/Getters/Get Vertex is on Edge Loop 
 Topology/Getters/Get Vertices Index from Edge 
 Topology/Modifiers/Apply Collapse Edge 
 Topology/Modifiers/Apply Delete Polygon 
 Topology/Modifiers/Apply Delete Vertex 
 Topology/Modifiers/Apply Disconnect Component 
 Topology/Modifiers/Apply Extrude Polygon Along Axis 
 Topology/Modifiers/Apply Invert Polygon 
 Topology/Modifiers/Apply Merge Polygon 
 Topology/Modifiers/Apply Merge Vertices 
 Topology/Modifiers/Apply Slice PolyMesh 
 Topology/Modifiers/Apply Split Edge 
 Topology/Modifiers/Apply Subdivide Locally 
 Topology/Modifiers/Apply Triangulate Polygon 
 Topology/Setters/Set Material ID from Cluster 
 Topology/Setters/Set Material ID 
 Topology/Setters/Set Materials from Library 
 Topology/Setters/Set Materials from Strings 
 Topology/Setters/Set Texture Projection Camera 
 Topology/Setters/Set Texture Projection Planar 
 Topology/Setters/Set Texture Projection Spatial 
 Topology/Setters/Set Topology 
 Topology/Setters/Set Vertex Position on Edge Loop 
 Topology/Shattering/Build Slice Planes 
 Topology/Shattering/Create Basic Shatter from Point Cloud 
 Topology/Shattering/Set Data from Chunk 
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ICE Modeling 

 

New ICE Modeling Nodes 

 Merge Topo (takes any number of topology inputs and will output a merged topology 

command list of all inputs)  

 Merge Topo Array (Merges an array of topologies together)  

 Slice Polygon (includes Delete and Cap options)  

 Apply Slice Polymesh compound (now much faster and can do multiple slices, deletes, 

and caps using array inputs)  

 Extrude Polygon Island (uses a Transform input instead of a vector)  

 Apply Extrude Polygon Along Axis compound (supports cluster, filter, or string inputs to 

define the components to extrude)  

 Create Topo (generates polygon meshes from arrays)  

 Topo Transform  

 Apply Extrusion along Strand  

 Create Strand from Curve compound (generates strands from several curves)  

 Get Topology compound (gets topology similar to what GetPointPosition does)  

 Get Topology (can be used to grab the current topology state of a mesh and clone it with a 

Set Topology)  

 Set Topology  

 Apply Slice Polymesh  

 Add Edge  

 Add Polygon  

 Add Vertex  

 Delete Polygon  

 Delete Vertex  

 Disconnect Component  

 Extrude Polygon  

 Invert Polygon  

 Local Subdivide  

 Merge Disjoint Vertices  

 Merge Polygon  

 Primitive Mesh  
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 Slice Polygon  

 Split Edge  

 Triangulate Polygon  

 For a complete list, see the Topology category in ICE > Tools tab.  

 String > String To Array (for example, used in the "Apply Extrude Along Axis" compound)  

 Builds a 2D array of values given an input string formatted as 
a comma or whitespace separated list of values.  
 The output array type is inferred at connection-time from the 
output port type. The types supported are:  
 
 Type Note  
 siICENodeDataBool   
 siICENodeDataColor4 Input string must contain groups of 4 
float values.  
 siICENodeDataFloat   
 siICENodeDataLong Values can be specified with a range syntax.  
 Example 1 Value: 1,2,3-5,6 Result:1 2 3 4 5 6  
 Example 2 Value: -3-1 2-4 7-5 8-10 -1 Result:-3 -2 -1 0 1 2 3 
4 7 6 5 8 9 10 -1  
 Example 3 Value: -3--1 -5--3 Result:-3 -2 -1 -5 -4 -3  
 siICENodeDataMatrix33 Input string must contain groups of 9 
float values.  
 siICENodeDataMatrix44 Input string must contain groups of 16 
float values.  
 siICENodeDataQuaternion Input string must contain groups of 4 
float values.  
 siICENodeDataVector2 Input string must contain groups of 2 
float values.  
 siICENodeDataVector3 Input string must contain groups of 3 
float values.  
 siICENodeDataVector4 Input string must contain groups of 4 
float values.  
 siICENodeDataRotation Input string must contain groups of 3 
float values.  
 Note: For complex types arrays such as siICENodeDataVector3 or 
siICENodeDataMatrix33, if the number  
 of items in the value string is wrong (for example, missing 
the Z coordinate), the output list will be empty. 

 Basic Math > Clamp  

 Statistics Math > Get Set And  

 New “Topology” attributes (for example, Self.Topology)  
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New Sample Scenes 

 XSI_SAMPLES/Scenes/ICE/Modeling_Basic_Shattering.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Columns_From_Strands.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Delete_Along_Edge_Loop.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Desks.scn" 

"Data/XSI_SAMPLES/Scenes/ICE/Modeling_Desks.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Road.scn" 

"Data/XSI_SAMPLES/Scenes/ICE/Modeling_Road.scn  

Syflex on ICE 

 ICE >Task Tab > Syflex  

 New sample scenes  

 Syflex Curve compound  

 Syflex Curve Springs compound  

ICE Flow and Suite Interoperability 

Now supports: 

 Starting in Softimage and sending to Maya  

 3ds Max workflow, starting from 3ds Max  

 Mudbox workflow, including Vector Displacement Maps rendering  

 Linux (for Maya and Mudbox)  

Animation  

 New shadow icons for bone primitives.  

Animation Editor 

 New simplified “Suites” mode (return to Classic from View menu)  

 Updated icons  

 New Isolate F-Curve (View menu and Icon)  

Cache Manager 

 Button to dump icecache header and attributes description into xml format.  
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 Option to reset all transforms before applying caches to objects (useful when cache is in 

global space)  

 Cache ICE sub-sampling attributes (scale with the same factor when loading into the 

mixer)  

Scene Layers 

 Scene layer groups allow you to make a layer the child of another layer, so that you can, 

for example, toggle the visibility from the parent. This replaces the previous 

implementation of layer groups, but old scenes won't be upgraded. A script could be 

written to convert the old layer groups to the new layer structure. Previously, "layer groups" 

were only a way to toggle the check box of all layers of a group at the same time. The new 

implementation works like groups-within-groups so that making a parent visible lets the 

child control its own visibility instead of forcing it on.  

 Layer groups now retain their settings  

 A single click on a row no longer sets current layer  

 User interface changed for Explorer > Layers  

 Only one level of hierarchy is supported (for example, a child layer cannot itself have a 

child)  

 Scene Layer Manager > Check/Uncheck All Menu  
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Texture Editor (TE)  

 UV pinning  

 UV pinning is not used within the TE for operations such as Heal, Collapse, etc. Only 

operations launched from the TE are supported. Commands such as Translate and 

Rotate will not take UV pinning into consideration. Other TE commands related to 

projections such as the ones in Planar and Cubic Subprojections are also not 

considered.  

 New selection mode for selecting pinned UV components. Pinned UV components 

cannot be selected in the TE unless the UV pinning selection mode is on. When turned 

off, UV components are ignored by the selection. UV pinning is supported by Heal, 

Island Heal, Flip, Relax, Match, Cycle, Paste UVW, Transform tools and Move 

Component.  

Weight Editor  

 The weight editor can now be used to edit any weight map or color-at-vertices map, and 

not just envelop weight maps.  

Rendering  

 mental ray 3.9.1.38 integration  

 New User Motion Cluster Property: A new vertex cluster property, named User Motion, 

allows you to control the motion vectors of each vertex of a polymesh object. When the 

User Motion cluster property is applied to an object, the motion blur is no longer computed 

and instead uses the motion data from this property. The simpler way to write on the User 

Motion cluster property is by using ICE.  

 Unified Sampling: The unified sampling is a vast improvement on the previous sampling 

algorithm. You can select the exact number of samples, rather than in increments of 

power-of-four. It also does away with the generic QMC sampler, and uses a new 

computation that doesn't suffer from the same diagonal artifacts as before. This only 

applies to scanline/raytracing however. For rasterizer, the unified sampling controls are 

just mapped into the existing rasterizer settings. Unified Sampling is turned off by default.  

 ICE attributes on meshes can now be accessed in the Render Tree by using the 

texture/weightmap/CAV shaders or the Get Attribute shaders. This is very useful when 
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doing procedural modelling, because you don't have to create clusters in advance for all 

the attributes that you want to access from the Render Tree.  

 Ability to choose the Vertex Color Display property from the Brush properties property 

editor.  

 Control UV Wrapping and UV Smoothing when using ICE attribute as UV: Added a 

mechanism to look for specific constant ICE attributes based on name. If you have a 

vector3 per sample named "MyUV1" doing a set data on "MyUV1_u_wrap" will enable you 

to control the texture wrapping mode used by the projection in the same way you do in the 

texture projection property editor.  

 Versioning support in contextual menus of shader compounds  

 Ability to set default file format for saved Preview image (last used format is remembered 

in a user preference)  

 Added a compression slider for .jpg in Viewport Capture. Also set default JPG quality to 

100%.  

FBX 

 Stereo camera I/O  

 Importing of Vector Displacement Maps from Mudbox  

 Support FBX SDK 2012  

 Added "Import Fbx..." under "File > Import" menu and "Export Fbx..." under "File > Export" 

menu  

 Added scripting commands to create the import/export options  

 Import *.3ds, *.dxf, *obj, *.dae formats  

 Ability to select target .fbx version such as 2010 (Motion Builder compatible), 2011, and 

2012  

 Multiple UVs supported in the FBX Importer/Exporter  

 Supports the import of CgFX materials  

 Supports neutral poses  

 FBX Single-step workflow to Mudbox  

 Materials: Phong, Lambert and Blinn are supported  

 Textures: normal, displacement, vector displacement map, ambient, specular, shiny, 

incandescence, bump, reflectivity and diffuse are supported  

SDK  

New Features 
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 Getting and Setting Size and Position for PPGs: New methods and functions were added 

to PPGLayout in the Object Model and the C++ API to allow for setting and getting the size 

and position of a modal property editor (also known as a PPG). See SetViewSize , 

SetViewPosition, ViewSize, and GetViewPosition in Object Model and C++ API.  

 Undo API: New methods and functions were added to Application in the Object Model and 

the C++ API to allow for opening and closing undo complexes and return true if a 

command is undoing or redoing. See OpenUndo, EndUndo, and IsUndoing in Object 

Model and C++ API.  

 UVProperty Pinning API: New C++ and Object Model API for marking cluster components 

as pinned or unpinned. This API is mainly used by the UVUnfold feature. See UVProperty 

in Object Model and C++ API.  

 Schematic View and Nodes API:  

 New C++ and Object Model API for manipulating the schematic view nodes. See 

Schematic and SchematicNode in Object Model and C++ API.  

 New menu anchor points: siMenuSchematicViewID, siMenuSchematicViewContextID, 

and siMenuSchematicNodeContextID.  

 New SchematicDemo example added to the SDK Examples Workgroup.  

 Scene Layer Manager API:  

 New menu anchor points: siMenuSceneLayerManagerLayersID and 

siMenuSceneLayerManagerContextID.  

 New view attribute selectedlayer. Available for View.GetAttributeValue only.  

 New Events:  

 siOnBeginCommand: Fired when a command is about to be executed. The event can be 

used to abort the command execution, modify the command argument values or 

launch other commands.  

 siOnEndCommand: Fired when a command has been executed. The event can be used 

to access the command return value or output argument values. Contrary to other 

event types, this event is always fired when the current command has been aborted by 

a previous event.  
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 siOnRenderAbort: Fired when a render sequence has been aborted by the user. The 

event can also be sent when a render region job is re-executed as a result of a scene 

change.  

 Added ActionSource support for siFileTypeAction to siOnBeginFileImport and 

siOnEndFileImport events. Now siOnBeginFileExport/siOnEndFileExport and 

siOnBeginFileImport/siOnEndFileImport events support Action and Shape actions.  

 Interactive Tool SDK:  

 New ToolContext class added to the C++ API for building plug-in tools that can be used 

in 3D views.  

 New Math classes CLine and CPlane used by the Tool SDK.  

 Tool Wizard in the Plug-in Manager.  

 New CustomTool example added to the SDK Examples Workgroup.  

 Image Clip and Bitmap Controls:  

 New Image Clip Control in PPGLayout (siControlImageClip): A control that shows an 

Image Clip. A string parameter sets the Image Clip full name. Supported attribute is 

siUIShowClip Set to True to show the thumbnail of the Image Clip control. The control 

toolbar is always displayed, regardless of this attribute value.  

 Static Bitmap control (siControlBitmap): Use siUIFilePath to set the bitmap to show.  

 For an example of both, see PSetUIDemo in the SDK Examples Workgroup.  

 Support for Menu Checkmarks: A new method and two functions where added to 

MenuItem in the Object Model and the C++ API to support menu checkmarks. See 

MenuItem.Checked, MenuItem::IsChecked, and MenuItem::PutChecked in Object Model 

and C++ API.  

 Scripting Shortcuts for Python: New Object Model shortcuts were added to siutils.py to 

facilitate python scripting.  

 Behavior Changes in the SDK:  

 The Layout.CreateView method and the Layout::CreateView function now display the 

name (in the titlebar) of the created view.  

 Scripts can no longer change the number of undo levels permanently. This prevents 

problems that occured when scripts set the number of undo levels to 0 to increase 

performance, and then failed to set it back or terminated abnormally.  
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Object Model Changes 

 New Objects  

 Schematic  

 SchematicNode  

 UVProperty  

 New Methods  

 Application.OpenUndo  

 Application.EndUndo  

 Application.IsUndoing  

 MenuItem.Checked  

 PPGLayout.SetViewSize  

 PPGLayout.SetViewPosition  

 PPGLayout.ViewSize  

 PPGLayout.GetViewPosition  

 New Constants  

 siControlImageClip  

 siControlBitmap  

C++ API Changes 

 New Classes  

 CLine  

 CPlane  

 Schematic  

 SchematicNode  

 ToolContext  

 UVProperty  

 New Functions  

 Application::EndUndo  

 MenuItem::IsChecked  

 Application::IsUndoing  

 Application::OpenUndo  

 PPGLayout::GetViewPosition  

 MenuItem::PutChecked  
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 PPGLayout::SetViewSize  

 PPGLayout::SetViewPosition  

 PPGLayout::ViewSize  

Scripting Command Changes 

 New Commands  

 CreateLayerGroup  

 FBXGetPluginVersion  

 FBXGetSDKVersion  

 PinAllUVComponents  

 PinUVComponents  

 UnpinAllUVComponents  

 UnpinUVComponents  
 

What’s Fixed 

 

These are the fixes that were made during the development of Softimage 2012.  

User Interface 
FELX‐1392  file browsers defaulting to desktop 
FELX‐1198  Weight editor does not refresh on object selection on newly duplicated objects 
FELX‐788  Grow Selection command buttons on custom toolbars doesn't work 
FELX‐605  Regression | Key properties have disapeared from the Profile curves PPG 
FELX‐799  Flipbook doesn't make LZW compressed Tiff files 
ACSO‐25  Animation Editor | Freeze with an animated boolean parameter 
ACSO‐213  Animation Editor | Freeze with an animated boolean parameter 
ACSO‐55  Crash with TortoiseSVN on File Browser 
ACSO‐65  Hiding the Netview toolbar twice through scripting crashes Softimage 
ACSO‐73  A preference for Help Language Japanese is not kept 
ACSO‐105  Draggin some workgroup shaders in the render tree can create a different one 
ACSO‐126  Save scene without RedrawUI kills collapse info of schematic. 
ACSO‐121  A radius of 0.01 is not small enough during paint brushing 
FELX‐1259  Exporer | Operators no more shown under Camera Primitive 

FELX‐991 
Loading a scene not in a project will create an invalid entry in the Recent Scenes 
menu 

FELX‐142  Request for a STOP button in playback 
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Texturing 
FELX‐953  ACSO‐166 ‐ TextureSpaceWidget does not differenciate objects under Models 
FELX‐992  one‐click interop: Softimage should respect TIFF tag to avoid upside down images 
FELX‐1493  UV Pinning undo problem 
ACSO‐64  Multiple Image Properties cannot edit at a time 

Modeling 
ACSO‐22  Crash when transferring in a single step all properties between meshes 

ACSO‐58 
Camera‐view display is corrupt when using Tweak User Normals Tool and Add Edge 
Tool 

Realtime Shaders 

ACSO‐21 
RTS | Annotations with indices (e.g."sas.directionallight[2].color") are not supported 
properly 

ACSO‐74  PPGLayout update problem in 2011 RT shader 
ACSO‐75  siNotInspectable flag update problem in 2011 RT shader 
ACSO‐77  Crash setting camera mode to OpenGL with ultimaper scene 

FELX‐1624 
artifacts when painting vertex colors in realtime shader opengl viewport on meshes 
using custom realtime shaders. 

Reference 
Models   

FELX‐1670 
FELX‐1386 (Expressions on a material lost when you rename a reference model ) not 
fully fixed 

FELX‐1506  Texture map in reference models breaks upon delta creation 

FELX‐1778 
Import Reference Rig and Import REferenced Skinned mesh causes Softimage to 
Crash 

FELX‐1883  Crash persisting scenes 
FELX‐1813  Shaders don't always connect or display properly upon loading scene 

FELX‐1558 
RefModel : Setting resolution and apply constraint child objects will not update 
correctly 

FELX‐1555  RefModel : Expression is not updated when merge scene 

FELX‐1289 
RefModel : Primitive is shifted incorrectly to another layer after applying 
MoveObjectToLayer 

FELX‐1750  Scene Material Corruption with Ref Models ‐ Continued 
FELX‐1702  Disconnected shaders when importing Referenced Model 
FELX‐1686  Expression on Material of a Model is lost after Importing the Model 
FELX‐1651  Scene Corruption in Felix due to Material 

Caching 

FELX‐749 
Cache ‐ Load shape attribute (that reference object in the scene) might be bound to 
the wrong object 
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FELX‐726 
Caching ‐ Load cache doesn't create attributes definitions if the first frame in the 
timeline isn't cached 

FELX‐718 
Cache manager ‐ Read ‐> Apply All should load the cache in the mixer with a scale 
corresponding to the subframe sampling 

FELX‐1365  ICE Cache: Can't read all Lagoa attributes (crash) 
FELX‐1361  Cache Manager: Start End Frames never persisted 
FELX‐1360  Cache Manager: Two caches loaded instead of one 

FBX 
FELX‐1836  FBX warnings shouldn't pop UI when imports occcur at cmd line. 
FELX‐1772  objects sent from 3ds Max do not update 
FELX‐1064  FBX: Node conecting to the reflectivity port of Lambert is missing during export 
FELX‐1024  FBX scriptings commands missing in Help and softimage.wiki.softimage.com 
FELX‐1884  OneClick Maya: Need a Send Entire Scene Option 

FELX‐1842 
Mudbox OneClick: Different updates from Mudbox have the same results in 
Softimage. 

FELX‐316  Ability to import and export stereo camera rigs in FBX plug‐in and ICEFLOW. 

FELX‐1576 
ICEFLOW ‐ Need better warning when sending stuff from XSI to Max without having 
sent nothing from Max first. 

ICE 
FELX‐1142  Corrupt frame numbers with "String File Path Sequence" ICE node 
FELX‐363  SDK ICE: Multi‐Phase Node fails to pull Data 
FELX‐373  ICE 'Cache on File' node: File Name & co parameters not visible when 'Read Cache' 
FELX‐1148  setdata to envelope map problem 
FELX‐1209  ICE | New node to get per element data into a singleton array 
FELX‐1771  Lagoa Crash | Rotating Object that has a child emitter 

FELX‐996 
Lagoa scenes and compounds should be updated to comply with sub‐frame 
interpolation. 

FELX‐377  Lagoa Collision Add Passive Body 
FELX‐364  Lagoa Preset images path is wrong 
FELX‐1323  ICE and lights: "Get data" node the "This." statement doesn't always work. 

FELX‐1283 
ICE | Get Data with self.kine.global works no more on Camera Primitive (compared 
to Softimage 2010) 

FELX‐1112  crash connecting stuff up that shouldn't be 
FELX‐959  ICE | GetSetAnd acts like GetSetOr 

Rendering 
FELX‐1741  Frame token padding behaves differently than documented. Docs are inconsistent. 
FELX‐1358  More than one dash (‐) in a frame set, crashes Softimage 

FELX‐1838 
Saving a rendered frame from the Preview Window without setting a file format 
results in .avi file 

FELX‐1634  Texture projections do not render correctly if named "color" 
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ACSO‐110  
Add the possibility to choose the Vertex Color Display Property from the Brush 
Properties PPG 

FELX‐1649  PPG Logic OnChanged can't be use for Color parameters. 
FELX‐183  Ability to set default fileformat for saved Preview image 
FELX‐1803  Texture Editor: Add UV pinning to TE operations 
FELX‐677  Allow users to set maximum OpenGL texture width to values greater than 2048 
FELX‐1419  Problem loading scene if rendertree Node name and ports are the same 

FELX‐1545 
MR Notification Problem | render region refreshes but does not render is not 
updated 

FELX‐1430  Discrepancy between OGL and Mental ray display of ICE Color Attribute 
FELX‐549  Using Geometry based Area Lights Dampens other lights 
FELX‐792  CRASH Rendering With Irradiance Particles 

FELX‐1239 
Notification filtering through connections is missing scalar ouptut nodes in the 
renderer process callback 

FELX‐1235  Scene render options reports wrong frame range with getValue() 
ACSO‐31  Invalid render region dimensions after being resized interactively 
ACSO‐35  3rd party renderers (e.g. Arnold) crash on Linux 
ACSO‐44  Custom renderer DirtyList isn't cleared properly 
ACSO‐45  AbortEvent breaks 3rd party renderers 
ACSO‐46  libsiutilityshaders shader dependency 

Capture and 
Compositing 
FELX‐190  Default value for preferences.Compositing.MaxCPUThreads to 8 

FELX‐1441 
Missing compression slider for .jpg in Viewport Capture. Also set default JPG quality 
to 100% 

SDK 
FELX‐1719  SDK Doc: OneClick commands not documented 
FELX‐1776  SDK Example: New python TCP server example 
FELX‐1463  SDK: Csharp plugin items stop working after NewScene 

FELX‐1654 
BoxTransformTool example manipulator fails on objects without geometry (lights, 
nulls, ...) 

FELX‐1284 
Crash when opening a Scintilla instance once the PythonWin Debugger has been 
opened 

FELX‐1903  Can't set GUID_PropertyMappingAttribute with the ShaderParamDef API. 
FELX‐562  More Menu anchor Points and Access to View Attributes 
FELX‐1562  Custom Property Wizard is buggy 

FELX‐1596 
When uninstalling Softimage XSIPython removes python from all previous Softimage 
installations 

ACSO‐130  PlotConstrainedTransforms command always popup dialog. 

ACSO‐175 
FCurve.RemoveKeys and FCurve.RemoveKeysAtIndex don't refresh the FCurve 
Editor and the timeline 
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ACSO‐72  SDK: "ClassName" of assigned material does not get expected class. 
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Autodesk MotionBuilder 2012 Release Notes 

This document describes known limitations, issues and fixes in Autodesk MotionBuilder 2012. It is 
strongly recommended that you read this document before you install this release. For reference, you 
should save this readme to your hard drive or print a copy. 

Contents  

Additional Resources .................................................................................................................................... 1 

What’s New ................................................................................................................................................... 1 

What’s Fixed? ................................................................................................................................................ 9 

Feature Limitations and Notes .................................................................................................................... 10 

Additional Resources  

For complete instructions about uninstalling and installing MotionBuilder 2012 see: 
www.autodesk.com/motionbuilder‐faq‐2012‐enu 

For complete documentation and resources, see: www.autodesk.com/motionbuilder2012‐
documentation 

For hardware qualifications, see: www.autodesk.com/MotionBuilder2012‐hardware 

To report issues with this release, see: www.autodesk.com/MotionBuilder2012‐support 

For more resources, see: www.autodesk.com/MotionBuilder2012‐learningpath 

What’s New 

This section briefly describes new features in this release. Please refer to the What’s New in the 
MotionBuilder Help for more detailed descriptions: www.autodesk.com/motionbuilder2012‐
documentation. 

Time Code Property 

A time code property has been added which allows users to associate time code to animation.   

Dark Look and Qt Dockable UI 

MotionBuilder has adopted a dark look UI. As well as the update of many icons, you now have the ability 
to dock and float tool windows.  

New Layouts 

Preset layouts have been updated to the following:  Editing, Scripting, and Preview. 
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Custom Layouts Menu Options 

New options have been added to the Layout menu relating to custom layouts. “Create custom” allows 
you to save any new layout. Enable the “Auto‐update Layout” if you wish to automatically save all 
custom layout modifications.  

New Marker Types 

Additional types have been added to the properties list for markers.  Users can choose to display a 
marker as any of the following marker types: cube, hard or light cross, sphere, capsule, box, bone, circle, 
square, or stick.  

Use Image Sequence 

An “Image Sequence” option has been added to the Video settings pane. 

Visibility Inheritance 

Visibility of a parent node can now be inherited by all children. A property has been added so that it can 
be enabled for each object as needed. New objects created in MotionBuilder 2012 have this property 
set on by default to help keep performance optimal. 

Recording and Storing Vertex Animation/Point Cache 

MotionBuilder now supports the recording and playback of point cache data on models. Point cache can 
boost performance on animation intensive scenes or to transfer animation based on complex constraint 
or physics set‐ups into other applications using FBX. 

A python sample script is provided for recording and playing back point cache animation on characters.  
The script can be found here:  Asset Browser > Scripts > Samples > PointCache > CharacterPointCache.py 

New classes:  

• FBPointCacheManager 

• FBDeformer 

• FBDeformerType 

• FBPoint‐CacheFile 

Added to FBCharacter class:  

• GetSkinModelList( FBModelList& pSkinModelList ) 

Added to FBModel class: 

• NoFrustumCullingRequire()  

• NoFrustumCullingRelease()  

• UseFrustumCulling() 
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Deformers: 

• SkeletonDeformable 

• BlendShapeDeformable 

• ConstrainDeformable 

• PointCacheDeformable 

Nurbs Curves: 

• Nurbs Curves from Maya are now supported in MotionBuilder 

Stereo Camera Rig 

A stereo camera is now available in Motionbuilder. 

New classes: FBCameraStereo, FBCameraStereoType, FBStereoDisplayMode 

Extended classes: FBVideoGrabOptions 

Auto Key Type 

Auto key type behavior has changed. To prevent overshooting or undershooting of fcurves caused by 
the Bezier Auto and User interpolation, a new clamp functionality with ease in and ease out has been 
added.  

Update to HIK 4.5 

The default character solver in MotionBuilder has been changed to HIK 4.5. HIK 3.6 and 4.0 have been 
removed from this version. 

New Characterization Tool 

MotionBuilder has implemented the new HIK Characterization Tool. This tool gives users access to bone 
mapping templates for HIK, Biped, and CAT skeletons, as well as mirroring functions, and instant 
notification when a characterization process is incomplete.  

New Character Controls 

The Character Controls window has also been updated with a new look and some additional controls.    

Vertex Color Display 

Vertex color shading of models is now supported in MotionBuilder.    

The following parameters have been changed in FBGeometry class: 

• VertexInit(int pSize, bool pResize, bool pInitUV = true, bool pInitVertexColor = false) 

• VertexAdd(FBVertex pVertex, FBNormal pNormal, FBUV pUV, FBColorF pVertexColor) 
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The following additions have been made to FBGeometry Class: 

• VertexColorSet(FBColorF pColor, int pIndex=‐1) 

• VertexColorSet(float pRed, float pGreen, float pBlue, float pAlpha, int pIndex=‐1) 

• VertexColorGet(int pIndex=‐1) 

• VertexColorMappingMode  

• VertexColorReferenceMode 

• GetVertexColorsIndexArray(int& pOutArrayCount) 

• GetVertexColorsDirectArray(int& pOutArrayCount) 

A new sample has been created to demonstrate simple geometry creation and vertex color display 
setting, and be found here: Asset Browser > Scripts > Samples > Geometry > VertexColor.py 

Consistent F‐Curve Editor 

The f‐curve editor has been improved to be more consistent with other Autodesk applications.   

Frustum Culling 

Frustum culling will prevent the rendering of anything outside the current camera viewport.  This option 
is turned on by default, but users can press CTRL+Shift+P to toggle the setting on and off. Press Shift+F 
to display the frame and evaluation rates, and the on/off state of the Frustum Culling; all are listed in 
the Evaluation line.  

GPU Skinning 

GPU skinning is now disabled by default on machines with 4 or more cores. Use the CTRL+Shift+D 
shortcut to enable GPU skinning if required. 

Profiling Tools 

Profiling tools are available to allow users to monitor scene performance as well as pinpoint where 
performance cost is highest. 

Profiling is available for:  

• Evaluation: Models, Constraints, Characters, Story Tracks,  

• Devices: Device Input, DevicesNotify, Devices Output 

• Rendering: Renderer, RenderPassGroup(Translucent, TranslucentZSort, Selected, 
OtherPrimitive, SelectiveLighting, etc), ShadeModelPass 

• New classes:  FBProfiler, FBProfileDutyCycle, FBProfileTimeEvent, FBProfileHelper  

Synchronization of Animation with Physics 

A new physics solver property has been added. Enable ForceAnimationSync when the computation of 
the physics takes longer than animation. Note that this means animation will only play when physics is 
live, and animation playback could be slower.    
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Live Video Input Capabilities 

Configure a webcam on your system and launch MotionBuilder. The device appears in the Navigator > 
Videos folder. Click Online and view and record live video directly inside MotionBuilder. 

Up‐Vector Settings Have Been Added to the Path Constraint 

Path constraints now have an option to set an up‐vector. Enable “Follow Path” option in the constraint 
properties to access these options. 

Real‐Time Relation Constraint Filter 

This filter applies a low‐pass filter to incoming live data. 

Audio Link to Take 

You can now assign an audio file to a particular scene take. This option is located in the Audio Settings. 

Displacement Box for Use in Relation Constraint with Devices 

This box has been created to eliminate the dependency on display frame rates when using Relation 
Constraints with Physics.  

New Python Classes 

The following new classes have been exposed in Python: 

• FBOpticalGap 

• FBModelOpticalAdvanced 

• FBOpticalSegment  

• FBRigidBody 

• FBModelMarkerOptical 

• FBPropertyListMarkerSegment  

• FBPropertyListOpticalSegment  

• FBPropertyListOpticalGap 

• FBModelOpticalAdvanced 

• FBPropertyEnumBase 

Exposure of Simple Math Functions in Python 

The following simple math functions have been exposed in Python:   

• Matrix 

• T,R,S to Matrix 

• Matrix to T,R,S 

• Local/Global conversions 

• Vector operations 
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• Quaternion operations 

• Vertex operations 

• Rotation utilities 

• Miscellaneous utilities 

Extended Classes 

The following classes have been extended:   

• FBVector2d 

• FBVector3d 

• FBVector4d 

• FBSVector 

• FBNormal 

• FBVertex 

• FBUV 

• FBColor 

• FBColorAndAlpha 

• FBMatrix. 

New Samples 

The following new samples can be found in the Asset Browser > Scripts > Samples > Math: 

MathUtilities.py (shows the global functions for math) 

Matrix.py (shows extended functions for FBMatrix) 

Vectors.py (shows extended functions for Vectors) 

Hybrid Motion Capture Device 

The plotting requirement after plotting has been removed and users can now record both optical and 
bone data simultaneously. 

New function for FBAnimationNode 

The following new function has been added: 

• WriteGlobalData( double* Data,HFBEvaluateInfo pEvaluateInfo ) 

New Sample Projects 

The following new sample projects have been added.  

• A combination of optical and skeleton device template 

• deviceopticalhybrid 
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• Server to provide test data  

• Opticalhybriddevicetester 

Exposure of TimeWarp  

The functionality of the TimeWarp curve has been exposed in the SDK. 

New class:  FBTimeWarpManager 

The following new sample can be found in the Asset Browser > Scripts > Samples > FCurve > 
TimeWarp.py 

Setting the Initial State of a Checkbox using FBTree 

The class FBTreeNode has a new Boolean attribute: When checked it is used to change the state of 
CheckBoxes created with FBTree. 

GetVertexArrayDuplicationMap added to FBModel Class 

To accelerate real‐time rendering, MotionBuilder will pre‐process the vertex data.  Those control points 
which have multiple attributes, such as normal, UV, etc., will be duplicated in order to have VBO (vertex 
buffer object) alike format.  This function will return the original vertex mapping IDs for those new 
(duplicated) vertexes. 

Distribution of Boost Library 

A new chapter “Custom development with Open Reality & PYFBSDK” has been added to SDK Help. This 
topic focuses on exposing the Open Reality SDK to Python using a third party library called Boost.Python. 
This allows users to add functionality to the ORSDK object and export that to Python.    

A new sample has been added in the ORSDK: pyfbsdk_template. 

New Python Sample for Merging Animation Layers 

Merging animation layers is now exposed through both C++ and Python. It is demonstrated in the new 
Python sample script MergeAnimationLayer.py 

New Python Sample for FBClusterTransactions 

Shows you how to access the cluster and cluster index while using the cluster transactions. 

Python/SDK documentation 

The Qt section has been revised with a detailed step‐by‐step tutorial.  A new chapter "Custom 
development with Open Reality & PYFBSDK" has been added. This topic focuses on exposing the Open 
Reality SDK to Python using a third party library called Boost.Python. 

Changes in Roll Bones Default Settings 

Roll Bone Extraction settings in the Character properties have changed.   
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When no roll bones are present: 

• Arm Roll Mode is set on and all Arm Roll sliders are at 100. 

• Leg Roll Mode is set off and all Leg Roll sliders are at 100. 

When roll bones are present: 

• Arm and Leg Roll Mode is set on and all Roll sliders are at 60. 

Changes When Working with Additive Reference Mode 

To reduce evaluation time and therefore increase frame rate, objects will not automatically be set to 
animatable when loaded or imported in MotionBuilder. This saves the evaluation engine considerable 
time because it is not forced to loop through each object’s transformation fcurves n times per second. A 
substantial savings will be found with scenes containing larger numbers of static meshes.  

Users will see similar behavior and will be able to key objects as usual. Additive rotation, however, will 
require the user to manually set the rotation property to animatable in order to see values larger than 
180. 

New Clip Art Location 

Clip Art files are now located in:  

• C:\Autodesk\MotionBuilder 2012 64bit\Content\ClipArt 

• C:\Autodesk\MotionBuilder 2012 32bit\Content\ClipArt 

Samples folder has been moved inside the ClipArt folder. 

New Characters  

New characters have been added to the ClipArt\Characters folder. 

Configuration Files Relocation 

MotionBuilder configuration files are now written in a folder outside the Program File in order to be 
more compatible with Vista and Windows 7. The new location is: C:\My Documents\MB. 

MB_CONFIG_DIR 

Use MB_CONFIG_DIR environment variable to override the default location of the MotionBuilder 
configuration files. 

MotionBuilder Help and SDK on Autodesk.com 

Starting this release the MotionBuilder Help and SDK Help is being published to the Autodesk.com 
website as browser‐based help systems. By default, MotionBuilder 2012 will not include documentation 
and learning materials with the software installation.  
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Instead, MotionBuilder calls the help and other resources from a web location to provide you with the 
latest documentation available. This shift to publishing directly to the web means we can provide 
regular updates and additions to content in an ongoing manner. This change also significantly reduces 
the footprint of locally installed data to your machine and makes the install and uninstall of 
MotionBuilder quicker.  

View the MotionBuilder Help: www.autodesk.com/motionbuilder2012‐documentation 

View the MotionBuilder SDK Help: www.autodesk.com/motionbuilder‐sdkdoc‐2012‐enu 

What’s Fixed? 

The following list contains bug numbers and corresponding descriptions for issues fixed in this release. 

Bug Number  Description

365168  Broken ORSDK and Python Samples
371719  Constraints folders lose settings on reload
366139  Voice device relation connections not automatically created 
360198  Asset details no longer shows link to textures
351810  Cannot reset destinations in assign sources to destinations 
313677  Import options not remembered
360428  Save selection discards skinning information
360417  Sphere maps cause instability
366553  Keying on reach properties when keying in body part mode 
354748  Changes to Templates folder causes instability
305032  Align control rig has problems with HIK 4.5
375586  Control rig sync problems with HIK 4.5 
304209  Instability caused by setting FBSpreadCell::Style to kFBCellStle View 
310174  Selecting models from ORSDK is too slow when scene has more than 1000 

models 
371035  Property references not saved
376188  Custom Local View is not saved with scene
363335  Saving scenes with many takes causes instability
368194  Expression constraints lose connection to blend shapes after saving 
366131  Merge Append of characters breaks connections with characters in Story
367556  Shader properties are not animated on subtracks with ‘insert current take’
367265  Full screen viewport tiles vertically instead of horizontally 
360934  Hips translation in character definition is not saved
368611   Pop‐up still requires user input for batch processes
361014  Crash with copy/paste of video track
379518  Cannot trim video on a track after a save/open ‐ crash when deleting 
361001  Cannot see video file when trying to open through Story  > Insert Video File
379849  Story Video Track‐ Clips duplicated on Save/Re‐open
378259  AMC import – Dummy bones lost on import
378257  AMC import – Motion not merged on import 
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Bug Number  Description

376527  ASF import – File>Import without AMC not possible
234683  Load Character Animation not supporting plotting for Skeletons 
339057  HIK 4.5 rig effectors flip when manipulated with handles 
378257  AMC import not merging motion on entire hierarchy – only on root 
371311  PythonStartup folder not loading in correct order
342950  Bone size reset after merging .htr data on skeleton
344297  Drop down menu problems on dual monitor
360052  Handles manipulation broken on reload
358797  SaveSelected.py not saving in correct location
374761  Local custom view for properties not saved
377317  Global lighting fog colors reset when layouts change
377487  Macros with namespaces do not merge append correctly 
362904  Extrapolate animation curves is not saving with file
360683  Tabs not working for pop‐ups
360687  Python window always has focus for shortcuts

Feature Limitations and Notes 

The following section describes limitations and other notes about this release.  

Bug Number  Description

359926  Video and audio not synched when recorded with Slave Audio to Video option
359464  Instability can occur when recording video input to a take 
380182  CG Shader is not supported with stereo camera views
380331  Human limits not working with HIK 4.5
381784  Dynamic Lighting shader is not working with Transparency maps 
382027  Override in animation layer has no effect until keyframe is created 
380405  Namespace ‐ Relation macro connection reference
380516  Namespace not maintained on animation layers
380818  FBX Export from Python tools menu creates unstable files when they contain 

new features from 2012 
374138  File > Append breaks relation macros with namespace 
359588  MinSize not working in FBTool
378305  Image sequence does not support layer texture 
380722  Drop down menus in Character Settings are offset using custom layout
378561  DeviceSyncAnimationNodeNotify only triggers if device is selected internally
380995  Cannot add elements to sets with animated visibility
381784  Dynamic lighting shader is not working with transparency maps 
382027  Override in animation layers has no effect until a keyframe is created 
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Notes 

Recording Live Video 

Certain camera drivers seem to cause problems while recording. We found removing the driver resolved 
the issue.   

Video recorded with some cameras will be compressed by default despite setting compression to None 
in MotionBuilder.  This could affect playback on 64 bit since Quicktime is not supported. 

Vertices on a 3d Curve 

Vertices cannot be selected until user selects the first vertex and offsets it slightly, and then all vertices 
appear and can be manipulated normally. 

Cannot Adding Elements to Sets with Animated Visibility 

Scenes will have to be saved and reopened for visibility to be applied to new elements. 

Image Sequence 

Image Sequences are currently not embedded in scene files. 

Path Constraints 

Path constraints are not supported by FBX. Bake the animation onto the constrained object before 
importing into other software. 

Renaming Characters can remove definition 

Character definition could be removed when creating characters if Character is renamed before locking 
initial characterization. 
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Autodesk Mudbox 2012 Release Notes 

Autodesk® Mudbox™ digital sculpting and texture painting software gives modelers and texture artists 
the freedom to create production‐ready 3D digital artwork without worrying about the technical details. 
Designed by professional artists from the game, film, television, and design industries, Mudbox 
combines an intuitive user interface with a powerful creative toolset of stencils and brushes for ultra‐
realistic 3D character modeling, engaging environments, and stylized props.  

This document describes known limitations, issues and fixes in Autodesk Mudbox 2012. It is strongly 
recommended that you read this document before you install this release.  

Contents 

What's New ................................................................................................................................................... 1 

What’s Fixed? ................................................................................................................................................ 2 

Feature Limitations and Notes ...................................................................................................................... 3 

Additional Resources .................................................................................................................................... 5 

 

What's New 

This list provides a summary of new features in this release of Mudbox. Find complete new feature 
information in the "What's New" section of the Mudbox Help at: http://www.autodesk.com/mudbox‐
help‐2012‐enu‐whatsnew 

• UV‐less painting 

• Large texture datasets 

• Paint layer masks and blend modes 

• Editable stencils 

• Single step suites interoperability 

• Performance improvements 

• New brushes and brush options 

• Multiple joints 

• Pose presets 
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What’s Fixed? 

The following table contains bug numbers and corresponding descriptions for issues fixed in this release. 
 

Bug Number  Description

301892  Import As Layer should create layer with the name of the imported mesh.

305342 
Texture extraction when using limit surface sometimes wrong, because of 
valence. 

309936  Deselecting mesh in Object List does not deselect it in 3D View. 
312581  Subdividing a mesh where multiple polys share single edge crashes Mudbox.
314428  Slider interaction slow when 2k 32‐bit stamp image loaded. 
320264  Lock on layers is lost when file is saved and reopened.

324439 
When painting, wireframe disappears until the 3D View is refreshed (by 
rotating, for example). 

336327  Can’t set topological axis with FBX file. Workaround by subdividing once.
343947  Blur and Clone tools don't work properly with blend modes. 
344786  Falloffs don't update in Paint Tools.
346565  Crash selecting selection set in Object List after extracting normal map.

351055 
Vector Displacement Map should be added in Map extraction results dialog 
box. 

354109  Joints stop displaying but are still there when Create Joint is unsuccessful.

359643 
Transfer Details crashes Mudbox when the Subdivide target is Highest source 
level. 

363155  Deselecting objects in the Object List sometimes doesn't work. 

363203 
Painting is not correct  when using the Projection brush with stencils derived 
from a 16bit tiff,  32bit tiff, 16bit exr and 32bit exr. 

363273 
“Opacity” column in the Layers window has been renamed to "Strength". This is 
meant to prevent confusion with opacity paint layers. 

363294  Fix UV View drawing performance and quality.
364064  Black spots in extracted displacement map, with large distance of 24. 

364660 
Placement and orientation of stamps is not along brush direction on dense 
meshes with more than 2.5k base level. 

364665 

Linux: If you use the "Send to Mudbox..." option in Maya when Mudbox is 
closed, the Mudbox splash screen appears briefly, then Mudbox crashes and an 
FBX file is created in the /usr/tmp folder.  
On Linux, you must have Mudbox already open for the "Send to Mudbox..." 
option in Maya to work. 

364858 
Extracted map is empty when the target mesh is n‐sided, source is an upper 
subdivision level, and subdivision method is selected. 

364901 

Set the Max Texture Size preference to be greater than the resolution being 
imported if the image is greater than 4096x4096. This must be done before 
importing the image otherwise painting will be slow and areas of the texture 
will be missing. 

366522  Duplicate paint layer does not keep blend mode, opacity, visibility, lock status.
366522  Duplicate paint layer should remember blend mode, opacity, visibility, lock.
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366733 
Blurring transparent areas of a bump map (or even a fully transparent bump 
map) will produce dark grey semi‐opaque pixels on the map. 

366949 
The Color Chooser and Eyedropper select only 8 bit values which is not 
accurate. (Now selects 16 bit values.) 

368386  Incorrect display when undo posing joints with mirror joints. 
369079  Enable Direction property for Contrast, Fill, Scrape, and Wax. 
371393  Paint is lost on inactive Materials.
301204  Stencil is offset from brush stroke after stencil is scaled. 
336123  FBX: Negatively scaled objects are ignored on import.
358608  Freeze brush and undo not working for multiple objects. 

362454 
Rebuild Subdivision Levels does not unsubdivide back to original mesh with n‐
sided faces. 

362806 
Rebuilding subdivision levels fails on certain objects that have been subdivided 
in other programs and imported into Mudbox. 

364254  Create New Paint Layer doesn't remember Size property. 
364280  Rebuild Subdivision Levels changes the Vertex IDs of the high‐level mesh.
366513  Create Paint Layers with UV tiles gets wrong result, causes black layer.
367856  Wrong extraction of Transfer Paint Layer when there are two targets. 

  Hidden geometry becomes visible when stepping down a subdivision level.
  Paint undo is currently limited to 19 actions. (Changed to 50.) 
  Brush Size/Strength doesn't update in Properties if hotkey is used. 

Feature Limitations and Notes 

This section lists known limitations and workarounds for Mudbox 2012.  
Please report any additional issues using the online bug reporting form at:  
www.autodesk.com/mudbox‐bugreport or from the Help > Report a Problem menu item in Mudbox. 

Bug Number  Description

355804 
Creating a joint may be difficult if the mesh has a lot of detail.  Workaround: 
Create the joint at a lower subdivision level. 

355918 
Installation: Error that says the product key may be invalid and to re‐enter it. 
Workaround: Click OK on this dialog, click Next button again, and if product key 
is valid the installation continues. 

357041 

Mudbox on Linux does not get pressure events from Wacom tablets with 
Fedora 12/Redhat 6, QT 4.5. You can find more details in the bug report here:  
 
https://bugzilla.redhat.com/show_bug.cgi?id=569132 
   
There is a patch for Qt here:  
http://koji.fedoraproject.org/koji/buildinfo?buildID=160252 
 

358312 
Files that include 16 bit TIF maps will show errors with "Send to Maya..." 
operation. 

360224 
Mudbox crashes if the extraction map output file name contains %S in string 
(for example: AO_(%S).bmp). 

361565  Tumbling in the 3D View while importing a paint layer may cause Mudbox to 
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Bug Number  Description

exit unexpectedly.  Workaround: Wait until the load is complete. 

362133 
Creating a joint with Topology Weights doesn't work properly with non‐4‐sided 
meshes. Workaround: Use alternative Weights method. 

362857 

If the level of the source model is not the current level when extracting a map, 
the detail of lower sculpt layers will be missing.  Workaround: Ensure you 
display the required subdivision level before extracting the map, or select the 
current level in the Extract Texture Maps window to get the correct result. 

363366 
Transfer paint layer works incorrectly if target and source have overlapping 
UVs. 

366007 

The Transfer Details function works best on objects that are the same size, or 
larger, than the default Mudbox meshes. If the transfer produces artifacts on 
the target mesh, try scaling up the source and target meshes to the same size 
as the default head mesh. 

374126 
When using a non US‐English standard keyboard, some of the hotkeys may not 
work. Workaround: Set your IME to "English ‐ United States" while using 
Mudbox. For more information see your operating system documentation. 

376624 

Installation (Windows). Mudbox does not start from Japanese/multi‐byte path. 
If you install Mudbox to a custom location containing Japanese/multi‐byte 
characters and then attempt to open Mudbox, Windows returns an error. 
Workaround:  Do not install Mudbox to a custom location containing 
Japanese/multi‐byte characters. 

377770 
Send to 3ds Max: Changing units between Max and Mudbox causes 
unpredictable results. 

381451 

Due to recent changes made to the common shader, scenes that contain 
models using the older default material from 2010 are no longer supported in 
2012. Possible side effects: shadows may not display correctly and posing will 
not work. Workaround: Assign the 2012 materials. 

381496 

When painting or sculpting with symmetry ON, sometimes the result will not 
appear on the opposite side. Verify that you have the "Falloff based on Facing 
Angle" checkbox turned off. This is a known limitation with a combination of 
symmetry with the "Falloff based on Facing Angle" option. 

 

• To run Mudbox 2012 you must have a processor which is SSE3 compliant. Mudbox uses SSE3‐
specific code, which does not allow Mudbox to run on hardware which is SSE2 or previous.  

• Sculpting with the Stamp Spacing property turned on will cause the brush stamp to be offset to the 
cursor location when using a Wacom Cintiq or a Wacom tablet when the pen setting is set to Mouse 
mode. To correct this, add the environment variable "MUDBOX_USE_LOWRES_TABLET_DATA".  

• With ATi graphics cards, if you are seeing texture painting corruption such as painting black and 
artifacts, adding the environment variable "MUDBOX_PAINT_CONTEXT_FLUSH" may fix the 
problem. 

• Some users may be seeing incorrect GPU RAM reporting causing many warnings to pop up every 
time they create, merge, or change the visibility of layers. The environment variable 
"MUDBOX_FORCE_GPU_RAM" (on Windows only) lets you override the amount of GPU memory in 
megabytes that Mudbox sees. If you have an Nvidia Quadro 5600 and it reports 1 MB of GPU RAM 
(the hardware has 1.5GB), set the variable to 1536 (which is 1.5 * 1024) for that card. Values which 
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are not numbers will be ignored, and values will be clamped to the range 256 to 4096. 
Note: For more information on these environment variables, see the Environment Variables topic in 
the Mudbox Help.  

• On Mac OS X, release configurations may not build correctly. User must set the Active Architecture 
to x86_64 in Xcode.  
To do this:  
1. Open example project using Xcode.  
2. In menu bar, select Project > Edit Project Settings.  
3. Select the Build tab.  
4. Under Architectures in the Setting window, make sure the Architectures value is set to 64‐bit 
Intel.  
5. Close window and build using the Release configuration.  
PtexImporter example requires PtexExtractor example to be built and copied into PtexImporter's 
build directory for linking.  
To build Turntable example, install Qt and run moc on the example header files. See readme in 
example. 

• If you experience any difficulty launching the Mudbox Help using Internet Explorer, use an 
alternative browser such as Firefox, or download and install the Help locally from 
http://www.autodesk.com/mudbox‐helpdownload‐enu 

• If you previously installed any beta version (including Release Candidate versions) of Autodesk 
Mudbox 2012, you must uninstall and delete all system folders pertaining to the pre‐release 
versions before you can install the commercial version.  

Additional Resources 

For complete installation and licensing instructions refer to the Installation Overview and FAQ and the 
Licensing Guide. Access these guides from the Installation Help link of the Mudbox installer or find them 
here:  

http://www.autodesk.com/mudbox‐faq‐2012‐enu 

http://www.autodesk.com/me‐licensing‐2012‐enu 

Find new feature information in the "What's New" section of the Mudbox Help at:  
http://www.autodesk.com/mudbox‐help‐2012‐enu‐whatsnew 

Find learning resources for Mudbox at:  
http://www.autodesk.com/mudbox‐learningpath 

 
Watch videos to learn how to use Mudbox at: 

http://www.autodesk.com/mudbox‐trainingvideos 
Find support resources at: 

http://www.autodesk.com/mudbox‐support 
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For the latest list of certified hardware to run Mudbox 2012, including graphics cards, refer to the 
Mudbox 2012 certification chart located at: 

www.autodesk.com/mudbox‐hardware 
 
Find the Mudbox 2012 minimum system requirements at: 

http://www.autodesk.com/mudbox‐systemreq‐2012‐enu 
 
Find documentation and examples for the Mudbox SDK with your installed version of Mudbox here: 
\Mudbox2012 \SDK\doc or online here: 

http://www.autodesk.com/mudbox‐sdkdoc‐2012‐enu 
 
 
Customer Involvement Program (CIP) 
The first time you start Mudbox, the Customer Involvement Program dialog box appears. If you choose 
to participate in the Customer Involvement Program, Mudbox will automatically send Autodesk 
information about system configuration, what features you use most, any problems that you encounter, 
and other information helpful to the future direction of the product. For further information, see 
http://www.autodesk.com/cip. 
 
Customer Error Reports (CERs) 
We are able to improve the stability of Mudbox largely because of the Customer Error Reports (CERs) 
that users of our products submit. We thank you for taking the time to fill out these reports and ask that 
you include as much information as possible about what actions you were performing at the time the 
error occurred. These details raise the value of the report immensely and are very much appreciated by 
the Autodesk Mudbox Engineering team.  

For further information about CERs refer to http://www.autodesk.com/cer.  
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Autodesk SketchBook Designer 2012 Release Notes

Explore design concepts and produce stunning artwork with Autodesk® SketchBook® Designer 
illustration software. In addition to the sketching capabilities and quality results that professionals have 
come to expect from Autodesk® SketchBook® Pro software, SketchBook Designer enables professional 
designers and artists to use a hybrid paint and vector workflow for concept design illustration and 
graphic design. Within the intuitive SketchBook creative environment, even new users can be productive 
within minutes. 

This document describes known limitations, issues and fixes in Autodesk SketchBook Designer 2012. It is 
strongly recommended that you read this document before you install this release. For reference, you 
should save this readme to your hard drive or print a copy. 

Contents  

Additional Resources  ................................................................................................................................... 1 

What’s New  .................................................................................................................................................. 1 

Feature Limitations and Notes  ..................................................................................................................... 4 

Additional Resources  

For complete instructions about uninstalling and installing SketchBook Designer 2012, see: 
www.autodesk.com/sketchbookdesigner‐faq‐2012‐enu 

For hardware qualifications, see: www.autodesk.com/sketchbookdesigner‐systemreq‐2012‐enu. 

To report issues with this release, email: sketchbook.help@autodesk.com. 

For more resources, see: www.sketchbooknews.com 

What’s New  

This section contains a summary of the features that have been added to SketchBook Designer and 
improvements since the last release. 

Snap lines in curve‐by‐point 

When in Point Curve Mode, use Shift‐Alt to get snap lines and create 90 degree angles. 

Hover over a point or curve to get a black dot within a curve point. Press Shift and move your cursor to 
get a 90 degree snap line. 

With Shift pressed, move your cursor to get snap lines. 

Where two lines intersect, intersection snap lines appear. 
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Minimum curve length 

Set the minimum length in canvas pixels a curve can be. The default setting is 5 pixels. You can change 
this in the Preferences. See Changing Curve by Stroke preferences in the SketchBook 
Designer documentation for more information. 

For 3D files that have been flattened and brought into SketchBook Designer, remove all extra pixels 
created during the flattening process. This will improve the speed of opening and working in the file. 

When sketching, especially when using vectors, curves can be accidentally created. Having this setting 
on will remove any curves under the set length. 

Red dots 

When trying to flood fill an area, there are times when to your eye, the region is closed. However, to the 
system, it isn't. The red dots appear at the end of all open curves and were added to help you find the 
fill gaps. These dots, along with the addition of snapping make it easy to find the problem and correct it. 

Masks 

Use masks to add paint only where you want it. When creating a mask, use black for areas where you 
don't want paint. Use white for areas that you do. If you use a 50% grey, 50% of the paint will bleed 
through the mask. 

When a mask layer is selected, the options in the toolbar also appear red to remind you that you are 
working on a mask layer. 

Note Masks only work on paint layers. If content is on a vector layer, use Layer > Convert to Paint 
Layer to make the convent raster‐based. 

Create a mask layer 

Tap Mask access a menu with options for adding a vector or raster mask layer. Once a mask layer is 
created, tap it to turn mask visibility on and off. 

  

How do I know if a mask layer is active? 

In the Layer Manager, mask layers are red. When one is active it is not just highlighted red, but also 
fill red. 

When a check appears next to one, it is being used. When you remove the check from a mask layer, 
the mask is not in use. 

  

How do I access mask layer options? 

Tap the flyout to access mask layer options for setting opacity and applying symmetry. SeeChange the 
opacity of a mask or Create a symmetric maskin the SketchBook Designerdocumentation for more 
information. 

Note If you tap the flyout to the side and its properties are greyed out, the mask is not in use. Place a 
check next to the mask layer name it make it active and access these options. 
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Mask layer marking menu 

Tap the middle of a mask layer to access a menu with the following options: 

• New paint mask ‐ create a raster layer mask. 

• Delete mask ‐ delete the selected mask layer. 

• Duplicate mask ‐ make a copy of the selected mask layer. 

• Invert mask ‐ change the masked area to a paintable area and the paintable area to a mask. 

• Merge down ‐ combine the selected mask with the one below. 

• Clear mask ‐ remove all information from a mask layer without deleting the layer. 

• New vector mask ‐ create a vector layer mask. 

For additional information on creating, deleting, duplicating, inverting, merging, clearing, hiding, 

Text 

Text has been added to SketchBook Designer for annotation. Set the font, its size, spacing, position, and 

For additional information on adding and transforming text, see the SketchBook 

Select File > Recent files to see a list of your most recent projects and quickly access them. 

Use Preserve transparency to lock the alpha channel of a layer. Use this to paint only where there are 

Join the Autodesk Customer Involvement Program (CIP) and reap the benefits. The system and usage 

For additional information on joining the Customer Improvement Program or viewing your data, see 

UI pinning and W hotkey 

View hidden windows with the press of a key and keep others open. 

 hidden window at the touch of a button. 

transforming, and changing the opacity of a mask, see the SketchBook Designer documentation. 

more. Text is only available for vector layers. 

Designerdocumentation. 
Recent file list 

Preserve transparency 

pixels. For more information, see Preserve transparency. 
Customer Involvement Program 

data you provide allows Autodesk to both improve our products and build tools that can help optimize 
your software use. Data collected is used in accordance with our privacy policy. 

theSketchBook Designer documentation. 

View hidden interface 

Press the W key to view
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K

When using the W hotkey to

eep hidden windows up 

 see hidden UI, tap the pin in the right window corner to keep it visible 

St

re intersecting points that appear when a vector selection tool is active and you hover over an 

er to drag the curves around. 

en 

 vector curves to an SVG file. Elements, such as raster images, fill regions, brush 

layer properties flyout to turn the selected layer into an alpha channel 

 BLACK opaque. 

. 

after the key is released. 

ickers 

Stickers a
intersection. Drag a Sticker around to move the intersecting curves. 

With nothing selected, hover over an intersection. Tap‐drag the Stick

When curves are selected, the Sticker respects its neighboring grip points. Only the segment betwe
the Sticker and neighboring grips is affected. 

SVG export 

Export your saved
effects, and text will not appear in this file. 

Hide Inside and Hide Outside 

These options were added to the 
for all layers below it. 

Hide Inside makes everything

Hide Outside makes everything WHITE opaque

Feature Limitations and Notes  

tly working to resolve: 

ssue: Text is lost when you bake a symmetry layer. 

ed. 

sue: Vector curves become invisible if Guide curves are transformed. 

sue: Cannot install the 64-bit version of SketchBook Designer on a machine running 64-bit Vista or XP. 

e 

sue: Layer blend modes do not blend semi-transparent pixels correctly. 

sue: If the spacebar is pressed while the Color Picker is open (Alt key), the Selection tool will become 
permanently set to subtract mode. 

The following are a list of issues we are curren

 

I

Solution: Toggle symmetry on, once the text layer is bak

  

Is

  

Is

Solution: Update your video card driver to the latest 64-bit version, via Intel or another website, to meet th
requirements, then install the 64-bit version of SketchBook Designer. 

  

Is

  

Is

4 
 



 

5 
 

or display resolutions other than 1600 x 1200, the brush stroke will be offset 
m the cursor. When possible, we recommend working at 1280 x 1024. 

lution: Save your work as often as possible. 

Issue: Some users may encounter a tracking offset between the brush stroke and stylus. 

nce only occurs if 
e fills are dropped while transforming them.) 
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Solution: Restart the program. 

  

RESOLUTION DEPENANCY – F
fro

  

Issue: A frequency of random crashes has been recently noted. 

So

Cintiq users only 

  

Issue: Transforming vector fills reduces the performance of that layer. (Reduced performa
th
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